
 
 

 

 
 
 

Toyota Enhanced OBD II 

User Guide 



 

Warnings 
 
The exclamation point within the triangle is a warning sign alerting you of important 
instructions accompanying the product. Please observe all warnings.   
 

 

Do not operate the vehicle indoors. A running engine produces lethal carbon 
monoxide exhaust fumes that can seriously harm or kill you if inhaled. Only run the 
vehicle motor outdoors with proper ventilation. Many scan tool operations do not 
require a running motor. 

 

 

Do not attempt to operate or observe the scan tool while driving a vehicle. 
Driving requires the full attention of the driver. Operating or observing the scan tool 
will cause driver distraction and could cause a fatal accident.  

 

 

Ensure the PC, cable, and OBD II adapter do not interfere with the vehicle 
controls. A cable dangling in front of the foot pedals, gear shifter, or steering wheel 
can interfere with vehicle operation and cause a fatal accident. Always ensure the 
PC, cable, and OBD II adapter are securely fastened out of the way. If the scan tool 
and PC cannot be safely attached as to not interfere with the vehicle controls, then 
do not drive the vehicle with the OBD II adapter connected to the vehicle.  
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Terms of Use 
The Software contains proprietary and confidential information that is protected by applicable 
intellectual property and other laws. You may not modify or sell works based on the Software.  

The Software is for your personal use. We grant you a personal and non-exclusive license to 
use the object code version of the Software on a single Windows-based personal computer; 
provided that you do not (and do not allow any third party to) copy, modify, reverse engineer, 
create derivative works from, assign or otherwise transfer any right in the Software; and you 
will not modify the Software by any means. 

Disclaimer 
The “Product” is the complete Dyno-Scan for Windows product including hardware, software, 
user manual, and packaging.  

Auterra, LLC assumes no responsibility for any loss or claim by third parties which arise 
through the use of this Product. Auterra, LLC assumes no responsibility for any damage or loss 
caused by deletion of data as a result of a Product malfunction. Be sure to backup copies of all 
important data on other media to protect against data loss.  

The Software, and all accompanying files, data and materials, are provided "as is" without 
warranty of any kind, either expressed or implied, including, but not limited to, the implied 
warranties of merchantability and fitness for a particular purpose. The entire risk as to the 
quality and performance of the Software is with you. Should the Software prove defective, you 
assume the cost of all necessary servicing, repair or correction. 

AUTERRA, OR ITS PRINCIPALS, SHAREHOLDERS, OFFICERS, EMPLOYEES, AFFILIATES, 
CONTRACTORS, SUBSIDIARIES, OR PARENT ORGANIZATIONS, SHALL NOT BE LIABLE FOR ANY 
INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR OTHER DAMAGES INCLUDING BUT 
NOT LIMITED TO, LOSS OF PROFITS, LOSS OF REVENUE, LOSS OF DATA, LOSS OF USE OF THE 
PRODUCT OR ANY ASSOCIATED EQUIPMENT, DOWNTIME AND CONSUMER’S TIME OR FOR 
BREACH OF ANY EXPRESS OR IMPLIED WARRANTY OR CONDITION, DAMAGE TO THE VEHICLE, 
BREACH OF CONTRACT, NEGLIGENCE, STRICT LIABILITY OR ANY OTHER LEGAL THEORY 
RELATED TO THIS PRODUCT.  

Copyright 
1998-2008 Auterra, LLC. All rights reserved.  

Trademarks 
Windows® is a registered trademark of Microsoft Corporation. 
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CHAPTER 1 

Preface 

Congratulations on your purchase of an Auterra’s Toyota Enhanced OBD II software package. 
Please take time to read through these operating instructions and become familiar with the 
operating procedure.  

The Toyota Enhanced OBD II software is included with the Dyno-Scan™ for Windows software.  
A unique Toyota Enhanced Product Key is purchased to unlock the features. The upgrade 
works on all 1996 and newer Toyota, Lexus and Scion vehicles. The enhanced software allows 
you to: 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

Read enhanced diagnostic trouble codes (DTCs) from systems like ABS and airbag 

Display enhanced DTC definitions from Body and Chassis systems 

Turn off the ABS and airbag light 

View and record enhanced parameters/sensors 

View vehicle state encoded and bit values 

Supported Subsystems  
The Toyota Enhanced package supports these vehicle subsystems: 

Engine / Climate Control System / Immobiliser 

Engine Stop And Go 

Hybrid Vehicle 

Transmission 

4WD (4-Wheel Drive) 

T/M Control 

ABS (Antilock Brake System) 

TPWS (Tire Pressure Warning System) 

EMPS / EHPS (Electric Motor Assisted Power Steering) 

VRGS (Variable Gear Ratio Steering) 

EMS (Electromagnetic Suspension) / AHC (Active Height Control) 

KDSS 
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• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

Body / Gateway 

Body No 2 

Steering Pad 

Body No 3 

Body No 4 

Body No 5 

AVC-LAN Adopter 

Airbag / SRS (Supplemental Restraint System) 

OCC (Occupant Detect) 

Pre-Crash Safety 

Meter 

Clearance Sonar 

AFS (Adaptive Front Lighting System) 

Passenger Seat 

Rear Right Seat 

Rear Left Seat 

Right Rear Seat Switch 

Air-Conditioning 

Driver Door 

Passenger Door 

Rear Right Door 

Rear Left Door 

Tilt And Telescoping Steering Wheel 

Driver Seat 

Side Sunroof 

Mirror / Mirror Right 

Rain Sensor 

Combination Switch 

Smart Key 

Back Door 

Retractable Hardtop 
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• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

Immobiliser / Steering Lock 

Battery 

Wiper 

Mirror Left 

TDS (Theft Detection System) 

Power Source Control 

Master Switch 

Engine EFI / CSS (Cruise Control) 

ECT (Electronically Controlled Transmission) 

Hybrid Vehicle / CCS (Cruise Control) 

Hybrid Vehicle Battery 
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CHAPTER 2 

Requirements 

To use the S-200 Toyota Enhanced OBD II software package you must have one of these scan 
tool kits: 

• 

• 

• 

• 

• 

• 

A-302 Dyno-Scan for Windows CAN USB 

A-301 Dyno-Scan for Windows CAN  

A-500 DashDyno SPD 

A-501 DashDyno SPD ProPack 

The following Auterra software is required: 

Dyno-Scan for Windows 8.0.0 or higher 

OBD II adapter firmware 3.06 or higher 

Check the Dyno-Scan for Windows version in the Help > About Dyno-Scan…  

 
If you have an older version of the Auterra Dyno-Scan for Windows software, just download 
the latest software from our web site Downloads page. 

www.auterraweb.com/downloads.html 
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On Windows, you can check the OBD II adapter version using the Dyno-Scan software. After 
connecting to a vehicle, select Help > About Hardware. If the Hardware Adapter Version is 3.05 
or earlier, please contact Auterra for an adapter software and/or hardware upgrade. 

On DashDyno, the opening splash screen shows the “Ver B”. If this is 3.05 or earlier, please 
contact Auterra for a DashDyno software upgrade. 
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CHAPTER 3 

Installation 

The Toyota Enhanced OBD II software is already part of the version 8.0.0 or higher Dyno-Scan 
for Windows software. There is no CD ROM to be shipped – only a Product Key to unlock the 
features within the software. 

1 

2 

Purchase the S-200 Toyota Enhanced OBD II software from the Auterra web site. You will 
also need to purchase any Dyno-Scan for Windows or DashDyno scan tool kit unless you 
already own one. 

Email the following information to Auterra at: support@auterraweb.com 

• 

• 

• 

3 

4 

5 

6 

Your 4-digit order number used to purchase the S-200 Toyota Enhanced software. 
The order number is emailed to you after placing an order on our web site.  

Your existing Dyno-Scan for Windows Product Key. 

Your complete name and mailing address. 

Auterra Support will respond to your email with a Toyota Enhanced Product Key. Please 
keep this key in a safe place and do not lose it. 

Start the Dyno-Scan for Windows software. 

Go to the Help > Product Registration Keys… menu option. 

Press the Enter Product Key button and enter the Toyota Enhanced Product Key. 
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7 Congratulations! Your Toyota Enhanced software is now ready for use. 
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CHAPTER 4 

Using Toyota Enhanced Software 

Using your Toyota Enhanced OBD II software is easy, and this section shows you how.  

Connecting to Vehicle 
When connecting to a vehicle, the Connect dialog’s Vehicle Connection Type dropdown will 
show a “Toyota / Lexus / Scion Enhanced” menu option. Select this option and press the 
“Connect to Vehicle” button. 

 
The software will now detect the systems available on the vehicle.  

 
After the vehicle is detected, select the system to connect to and press the “Connect to 
System” button. 

 

8 Using Toyota Enhanced Software   



 

 
You are now connected to the selected Toyota Enhanced system. 

Once connected to the vehicle, you can switch systems quickly.  

1 

2 

3 

4 

Select File > Connect.  

On the Connect dialog, select the “Toyota / Lexus / Scion Enhanced” menu option.  

Press the “Connect to System” button. This button is only available after the vehicle has 
been successfully detected. 

On the “System Connect – Step 2” dialog, select the system and press “Connect to 
System”.  

General Information 
The Vehicle Monitor Test Status on the General Information screen will show bit and state 
encoded values from the enhanced system. 
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Trouble Codes 
The Stored Diagnostic Trouble Codes pane will show any DTCs stored on the enhanced 
system. 
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Clearing Trouble Codes 
Select the Tools > Clear DTCs menu option to clear codes and turn off any dashboard light 
(e.g. ABS or airbag). Clear DTCs will only clear codes for the currently connected enhanced 
system.  

Please note the following when clearing DTCs: 

1 

2 

3 

Some vehicles require the ignition key to be turned off then on again before the code is 
cleared.  

Some codes cannot be cleared while the vehicle is running.  

The dashboard light and diagnostic trouble code may not be clearable until the system 
repair has been completed.  

Live Data 
The Live Data screen shows sensor values for the enhanced system currently connected. Each 
enhanced parameter is marked with a § symbol (e.g. § Knock Retard). Some systems do not 
have live data parameters. 
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APPENDIX A 

Supported Parameters 

Live Data Sensors (CAN Bus) 

Engine EFI, Radar Cruise, Laser Cruise, CCS 
Knock Correction Learn 
Knock Feedback 
Misfire RPM 
Misfire Load 
Cylinder 1 Misfire Rate 
Cylinder 2 Misfire Rate 
Cylinder 3 Misfire Rate 
Cylinder 4 Misfire Rate 
Cylinder 5 Misfire Rate 
Cylinder 6 Misfire Rate 
Cylinder 7 Misfire Rate 
Cylinder 8 Misfire Rate 
All Cylinders Misfire Rate 
Ignition 
Multiple Cylinder Misfire Rate 
Misfire Margin 
Short Term Fuel Trim B1 
Short Term Fuel Trim B3 
Long Term Fuel Trim B1 
Long Term Fuel Trim B3 
Short Term Fuel Trim B2 
Short Term Fuel Trim B4 
Long Term Fuel Trim B2 
Long Term Fuel Trim B4 
O2 Sensor B1-S1 
Short Fuel Trim B1-S1 
O2 Sensor B1-S2 
Short Fuel Trim B1-S2 
O2 Sensor B1-S3 
Short Fuel Trim B1-S3 
O2 Sensor B1-S4 
Short Fuel Trim B1-S4 
O2 Sensor B2-S1 
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Short Fuel Trim B2-S1 
O2 Sensor B2-S2 
Short Fuel Trim B2-S2 
O2 Sensor B2-S3 
Short Fuel Trim B2-S3 
O2 Sensor B2-S4 
Short Fuel Trim B2-S4 
Equivalence Ratio B1-S1 
O2 B1-S1 Wide Range V 
Equivalence Ratio B1-S2 
O2 B1-S2 Wide Range V 
Equivalence Ratio B1-S3 
O2 B1-S3 Wide Range V 
Equivalence Ratio B1-S4 
O2 B1-S4 Wide Range V 
Equivalence Ratio B2-S1 
O2 B2-S1 Wide Range V 
Equivalence Ratio B2-S2 
O2 B2-S2 Wide Range V 
Equivalence Ratio B2-S3 
O2 B2-S3 Wide Range V 
Equivalence Ratio B2-S4 
O2 B2-S4 Wide Range V 
Equivalence Ratio B1-S2 2 
O2 B1-S1 Wide Range mA 
Equivalence Ratio B1-S2 2 
O2 B1-S2 Wide Range mA 
Equivalence Ratio B1-S3 2 
O2 B1-S3 Wide Range mA 
Equivalence Ratio B1-S4 2 
O2 B1-S4 Wide Range mA 
Equivalence Ratio B2-S1 2 
O2 B2-S1 Wide Range mA 
Equivalence Ratio B2-S2 2 
O2 B2-S2 Wide Range mA 
Equivalence Ratio B2-S3 2 
O2 B2-S3 Wide Range mA 
Equivalence Ratio B2-S4 2 
O2 B2-S4 Wide Range mA 
Pilot 1 Injection 
Pilot 2 Injection 
Main Injection 
After Injection 
Pilot 1 Injection 
Pilot 2 Injection 
Main Injection 
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After Injection 
Injection Feedback Value 
Injection Feedback Value #1 
Injection Feedback Value #2 
Injection Feedback Value #3 
Injection Feedback Value #4 
Injection Feedback Value #5 
Injection Feedback Value #6 
Injection Feedback Value #7 
Injection Feedback Value #8 
Injection Volume 
Purge Density Learning Value 
Purge Flow 
Engine Speed From EFI 
Intake Air Temperature From EFI 
Coolant Temperature From EFI 
Throttle Position From EFI 
Accelerator Position From EFI 
Shift Position From ECT 
A/T Oil Temperature From ECT 
SPD (NO) 
SPD (NT) 
Requested Engine Torque 
HV Target Engine Speed 
Actual Engine Torque 
Estimated Engine Torque 
Engine Run Time 
Request Engine Run Time 
Judgement Time for Ignition of Engine 
Judgement Time for Engine Output 
Estimated Intake Port Temperature   
Tank Outlet Water Temperature 
Water Flow Valve 
ISC Learning Value   
Cruise Control Vehicle Speed 
Cruise Control Memory Vehicle Speed 
Cruise Throttle Opening Angle 
Cruise Request Torque 
Throttle Position No. 1 
Throttle Position No. 2 
Accelerator Position No. 1 
Accelerator Position No. 2 
Clutch Current 
Throttle Motor Current 
Throttle Motor Opening Duty Ratio 
Throttle Motor Closing Duty Ratio 
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Throttle Sensor Opener Position No. 1 
Throttle Sensor Opener Position No. 2 
Accelerator Fully Closed Learning Value No. 1 
Accelerator Fully Closed Learning Value No. 2 
Throttle Position Command Value 
Throttle Sensor Opener Position No. 1 (AD) 
Accelerator Fully Closed Value No. 1 (AD) 
Accelerator Position No. 1 
Accelerator Position No. 2 
Throttle Position No. 1 
Throttle Position No. 2 
Throttle Requirement Position 
Throttle Motor Duty Ratio (Open) 
Throttle Motor Duty Ratio (Close) 
Throttle Step Position 
Throttle Aim Position 
Throttle Fully Closed Learning Value 
Throttle Motor Current 
Electomagnetic Clutch Current 
+BM Voltage 
SPD (NT) 
SPD (NC) 
SPD (NC0) 
SPD (NC2) 
SPD (SP2) 
A/T Oil Temperature 1 
A/T Oil Temperature 2 
A/T Oil Temperature 3 
NT Sensor Voltage 
NC Sensor Voltage 
NC0 Sensor Voltage 
NC2 Sensor Voltage 
SP2 Sensor Voltage 
SPD (NIN) 
NIN Sensor Voltage 
SPD (NOUT) 
NOUT Sensor Voltage 
A/T Oil Pressure 
G Sensor 
Fuel Temp 
Accelerator Position 
Throttle Position 
Diesel Throttle Angle 
VNT Command 
Pump VCM Angle 
IDL Stable Control 
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Common Rail Pressure 
Turbine Speed 
Accelerator Position 1 
Accelerator Position 2 
Alternate Duty Ratio 
Throttle Value Fully Closed 
Target Common Rail Pressure 
VNT Max Angle 
VNT Min Angle 
Ex Fuel Addition Feedback 
Injection Pressure Feedback Value 
DPNR A/F 
Differential Pressure Feedback 
EGR Learn Value 
EGR Step Position 
EGR Position 
EGR Gas Temperature 
EGR Close Learning Value 
VVT Aim Angle (Bank 1) 
VVT Change Angle (Bank 1) 
VVT OCV Operation Duty (Bank 1) 
VVT Aim Angle (Bank 2) 
VVT Change Angle (Bank 2) 
VVT OCV Operation Duty (Bank 2) 
VVT Exhaust Hold Duty Ratio Learning Value (Bank 1) 
VVT Exhaust Change Angle (Bank 1) 
VVT Exhaust OCV Duty (Bank 1) 
VVT Exhaust Hold Duty Ratio Learning Value (Bank 2) 
VVT Exhaust Change Angle (Bank 2) 
VVT Exhaust OCV Duty (Bank 2) 
Injection Timing (D4) 
SCV Status (D4) 
SCV Angle (D4) 
SCV Angle Sensor (D4) 
Fuel Pump Duty 
Injection Time (D4) 
SCV Duty Ratio 
ACM 
Power Steering Pressure Sensor 
DPNR Differential Pressure Sensor 
Air Pump Pressure (Absolute) 
Air Pump Pulsation Pressure 
Initial Engine Coolant Temperature 
Initial Intake Air Temperature 
Initial Exhaust Temperature (IN) 
Initial Exhaust Temperature (OUT) 
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Engine Coolant Temperature (IN) 
Intake Air Temperture (Turbo) 
Injection Volume (Cylinder 1) 
Injector 
Total Fuel Trim 1 
Total Fuel Trim 2 
Vapor Pressure 
Vapor Pressure 
Vapor Pressure (Calculated) 
O2 Lean-Rich Bank 1 Sensor 1 
O2 Lean-Rich Bank 2 Sensor 1 
O2 Rich-Lean Bank 1 Sensor 1 
O2 Rich-Lean Bank 2 Sensor 1 

ECT 
Engine Speed From EFI 
Intake Air Temperature From EFI 
Coolant Temperature From EFI 
Throttle Position From EFI 
Accelerator Position From EFI 
SPD (NT) 
SPD (SP2) 
A/T Oil Temperature 1 
 

HV ECU / CCS 
Motor (MG2) Revolution 
Motor (MG2) Torque 
Regenrative Brake Torque 
Request Regenerative Brake Torque 
Generator (MG1) Revolution 
Generator (MG2) Torque 
Request Power 
Target Engine Revolution 
Engine SPD 
Master Cylinder Control Torque 
Status Of Charge 
Wout Control Power 
Win Control Power 
Discharge Request To Adjust SOC 
Drive Condition ID 
Inverter Temperature (MG1) 
Inverter Temperature (MG2) 
Motor Temperature 2 
Motor Temperature 1 
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Power Resource VB 
Power Resource IB 
Shift Sensor Main 
Shift Sensor Sub 
Shift Sensor Select Main 
Shift Sensor Select Sub 
Vehicle SPD (Resolver) 
Difference Degree Of An Accelerator 
VL-Voltage Before Raising Pressure 
VH-Voltage After Raising Pressure 
Converter Temperature 
Crank Position 
Motor (MG2) Torque Execute Value 
Generator (MG1) Torque Execute Value 
Short Circuit Wave Highest Value 
Raising Pressure Ratio 
Air-Conditioner Consumption Power 
Generator (MG1) Revolution 
Motor (MG2) Revolution 
Generator (MG1) Torque 
Motor (MG2) Torque 
Request Power 
Engine SPD 
Master Cylinder Control Torque 
State Of Charge 
Wout Control Power 
Win Control Power 
Drive Condition ID 
Inverter Temperature (MG1) 
Inverter Temperature (MG2) 
Motor Temperature MG2 (No2) 
Motor Temperature MG2 (No1) 
Power Resource VB 
Power Resource IB 
Shift Sensor Shift Position 
Accel Sensor Main 
Auxillary Battery Voltage 
Exclusive Information 1 
Exclusive Information 2 
Exclusive Information 3 
Exclusive Information 4 
Exclusive Information 5 
Exclusive Information 6 
Exclusive Information 7 
Occurence Order 
Information N 
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Converter Temperature 
VL-Voltage Before Raising Pressure 
VH-Voltage After Raising Pressure 
The Time Of Ignition ON 
Inverter Temperature (MG1) After IG-ON 
Inverter Temperature (MG2) After IG-ON 
Motor Temperature (MG2) After IG-ON 
Converter Temperature After IG-ON 
Status Of Charger After IG-ON 
Inverter Temperature (MG1) Max 
Inverter Temperature (MG2) Max 
Motor Temperature (MG2) Max 
Converter Temperature Max 
Status Of Charge Max 
Status Of Charge Min 
vehicle Speed Max 
Air-Conditioner Consumption Power 
Generator (MG1) Revolution 
Motor (MG2) Revolution 
Generator (MG1) Torque 
Motor (MG2) Torque 
Request Power 
Engine SPD 
Master Cylinder Control Torque 
State Of Charge 
Wout Control Power 
Win Control Power 
Drive Condition ID 
Inverter Temperature (MG1) 
Inverter Temperature (MG2) 
Motor Temperature MG2 (No2) 
Motor Temperature MG2 (No1) 
Power Resource VB 
Power Resource IB 
Shift Sensor Shift Position 
Accel Sensor Main 
Auxillary Battery Voltage 
Exclusive Information 1 
Exclusive Information 2 
Exclusive Information 3 
Exclusive Information 4 
Exclusive Information 5 
Exclusive Information 6 
Exclusive Information 7 
Occurence Order 
Information N 
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Converter Temperature 
VL-Voltage Before Raising Pressure 
VH-Voltage After Raising Pressure 
The Time Of Ignition ON 
Inverter Temperature (MG1) After IG-ON 
Inverter Temperature (MG2) After IG-ON 
Motor Temperature (MG2) After IG-ON 
Converter Temperature After IG-ON 
Status Of Charger After IG-ON 
Inverter Temperature (MG1) Max 
Inverter Temperature (MG2) Max 
Motor Temperature (MG2) Max 
Converter Temperature Max 
Status Of Charge Max 
Status Of Charge Min 
vehicle Speed Max 
Air-Conditioner Consumption Power 
Generator (MG1) Revolution 
Motor (MG2) Revolution 
Generator (MG1) Torque 
Motor (MG2) Torque 
Request Power 
Engine SPD 
Master Cylinder Control Torque 
State Of Charge 
Wout Control Power 
Win Control Power 
Drive Condition ID 
Inverter Temperature (MG1) 
Inverter Temperature (MG2) 
Motor Temperature MG2 (No2) 
Motor Temperature MG2 (No1) 
Power Resource VB 
Power Resource IB 
Shift Sensor Shift Position 
Accel Sensor Main 
Auxillary Battery Voltage 
Exclusive Information 1 
Exclusive Information 2 
Exclusive Information 3 
Exclusive Information 4 
Exclusive Information 5 
Exclusive Information 6 
Exclusive Information 7 
Occurence Order 
Information N 
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Converter Temperature 
VL-Voltage Before Raising Pressure 
VH-Voltage After Raising Pressure 
The Time Of Ignition ON 
Inverter Temperature (MG1) After IG-ON 
Inverter Temperature (MG2) After IG-ON 
Motor Temperature (MG2) After IG-ON 
Converter Temperature After IG-ON 
Status Of Charger After IG-ON 
Inverter Temperature (MG1) Max 
Inverter Temperature (MG2) Max 
Motor Temperature (MG2) Max 
Converter Temperature Max 
Status Of Charge Max 
Status Of Charge Min 
vehicle Speed Max 
Air-Conditioner Consumption Power 
Generator (MG1) Revolution 
Motor (MG2) Revolution 
Generator (MG1) Torque 
Motor (MG2) Torque 
Request Power 
Engine SPD 
Master Cylinder Control Torque 
State Of Charge 
Wout Control Power 
Win Control Power 
Drive Condition ID 
Inverter Temperature (MG1) 
Inverter Temperature (MG2) 
Motor Temperature MG2 (No2) 
Motor Temperature MG2 (No1) 
Power Resource VB 
Power Resource IB 
Shift Sensor Shift Position 
Accel Sensor Main 
Auxillary Battery Voltage 
Exclusive Information 1 
Exclusive Information 2 
Exclusive Information 3 
Exclusive Information 4 
Exclusive Information 5 
Exclusive Information 6 
Exclusive Information 7 
Occurence Order 
Information N 
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Converter Temperature 
VL-Voltage Before Raising Pressure 
VH-Voltage After Raising Pressure 
The Time Of Ignition ON 
Inverter Temperature (MG1) After IG-ON 
Inverter Temperature (MG2) After IG-ON 
Motor Temperature (MG2) After IG-ON 
Converter Temperature After IG-ON 
Status Of Charger After IG-ON 
Inverter Temperature (MG1) Max 
Inverter Temperature (MG2) Max 
Motor Temperature (MG2) Max 
Converter Temperature Max 
Status Of Charge Max 
Status Of Charge Min 
vehicle Speed Max 
Air-Conditioner Consumption Power 
Generator (MG1) Revolution 
Motor (MG2) Revolution 
Generator (MG1) Torque 
Motor (MG2) Torque 
Request Power 
Engine SPD 
Master Cylinder Control Torque 
State Of Charge 
Wout Control Power 
Win Control Power 
Drive Condition ID 
Inverter Temperature (MG1) 
Inverter Temperature (MG2) 
Motor Temperature MG2 (No2) 
Motor Temperature MG2 (No1) 
Power Resource VB 
Power Resource IB 
Shift Sensor Shift Position 
Accel Sensor Main 
Auxillary Battery Voltage 
Exclusive Information 1 
Exclusive Information 2 
Exclusive Information 3 
Exclusive Information 4 
Exclusive Information 5 
Exclusive Information 6 
Exclusive Information 7 
Occurence Order 
Information N 
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Converter Temperature 
VL-Voltage Before Raising Pressure 
VH-Voltage After Raising Pressure 
The Time Of Ignition ON 
Inverter Temperature (MG1) After IG-ON 
Inverter Temperature (MG2) After IG-ON 
Motor Temperature (MG2) After IG-ON 
Converter Temperature After IG-ON 
Status Of Charger After IG-ON 
Inverter Temperature (MG1) Max 
Inverter Temperature (MG2) Max 
Motor Temperature (MG2) Max   
Converter Temperature Max 
Status Of Charge Max 
Status Of Charge Min 
vehicle Speed Max 
Air-Conditioner Consumption Power 
Cruise Control Vehicle Speed 
Cruise Control Memory Vehicle Speed 
Cruise Throttle Opening Angle", "" }, 
Cruise Request Torque 

HV Battery 
Battery State Of Charge 
Current Value Of Battery Pack 
Battery Block Voltage - V01 
Battery Block Voltage - V02 
Battery Block Voltage - V03 
Battery Block Voltage - V04 
Battery Block Voltage - V05 
Battery Block Voltage - V06 
Battery Block Voltage - V07 
Battery Block Voltage - V08 
Battery Block Voltage - V09 
Battery Block Voltage - V10 
Battery Block Voltage - V11 
Battery Block Voltage - V12 
Battery Block Voltage - V13 
Battery Block Voltage - V14 
Inhalation-Of-Air Temp Into A Battery Pack 
VMF Fan Motor Voltage 
Auxillary Battery Voltage 
Charge Control Value To HV-ECU From Batt-ECU 
Discharge Control Value To HV-ECU From Batt-ECU 
Delta SOC  
Cooling Fan Mode  
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Temperature Of Battery TB1 
Temperature Of Battery TB2 
Temperature Of Battery TB3 
Number Of Battery Block 
Accumulated Time Of Battery Low 
Accumulated Time Of DC Inhibit 
Accumulated Time Of Battery Too High 
Accumulated Time Of Hot Temperature 
Battery Block Minimum Voltage 
Minimum Battery Block No 
Battery Block Max Voltage 
Max Battery Block No 
Internal Resistance R01 
Internal Resistance R02 
Internal Resistance R03 
Internal Resistance R04 
Internal Resistance R05 
Internal Resistance R06 
Internal Resistance R07 
Internal Resistance R08 
Internal Resistance R09 
Internal Resistance R10 
Internal Resistance R11 
Internal Resistance R12 
Internal Resistance R13 
Internal Resistance R14 

EFI 
Calculated Load 
Engine Coolant Temp 
Fuel Rail Pressure (gauge) 
Intake Manifold Pressure 
Engine RPM 
Vehicle Speed 
Ignition Timing Advance 
Intake Air Temperature 
Air Flow Rate From MAF 
Absolute Throttle Position 
Time Since Engine Start 
Distance Traveled MIL On 
Fuel Rail Press Rel Manifold 
Fuel Rail Pressure 
Commanded EGR 
EGR Error 
Commanded Evap Purge 
Fuel Level Input 
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Warm-ups Since DTCs Clrd 
Distance Since DTCs Clrd 
Evap System Vapor Press 
Barometric Pressure 
Catalyst Temp B1-S1 
Catalyst Temp B2-S1 
Catalyst Temp B1-S2 
Catalyst Temp B2-S2 
Control Module Voltage 
Absolute Load Value 
Commanded Equival Ratio 
Relative Throttle Position 
Ambient Air Temperature 
Absolute Throttle Pos B 
Absolute Throttle Pos C 
Accelerator Pedal Pos D 
Accelerator Pedal Pos E 
Accelerator Pedal Pos F 
Command Throttle Actuator 
Minutes Run with MIL On 
Time Since DTCs Cleared 
Alcohol Fuel Percentage 
Absolute Evap Vapor Pres 
Evap System Vapor Pres 

ECT 
Calculated Load 
Engine Coolant Temp 
Fuel Rail Pressure (gauge) 
Intake Manifold Pressure 
Engine RPM 
Vehicle Speed 
Ignition Timing Advance 
Intake Air Temperature 
Air Flow Rate From MAF 
Absolute Throttle Position 
Time Since Engine Start 
Distance Traveled MIL On 
Fuel Rail Press Rel Manifold 
Fuel Rail Pressure 
Commanded EGR 
EGR Error 
Commanded Evap Purge 
Fuel Level Input 
Warm-ups Since DTCs Clrd 
Distance Since DTCs Clrd 
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Evap System Vapor Press 
Barometric Pressure 
Catalyst Temp B1-S1 
Catalyst Temp B2-S1 
Catalyst Temp B1-S2 
Catalyst Temp B2-S2 
Control Module Voltage 
Absolute Load Value 
Commanded Equival Ratio 
Relative Throttle Position 
Ambient Air Temperature 
Absolute Throttle Pos B 
Absolute Throttle Pos C 
Accelerator Pedal Pos D 
Accelerator Pedal Pos E 
Accelerator Pedal Pos F 
Command Throttle Actuator 
Minutes Run with MIL On 
Time Since DTCs Cleared 
Alcohol Fuel Percentage 
Absolute Evap Vapor Pres 
Evap System Vapor Pres 

HV 
Calculated Load 
Engine Coolant Temp 
Fuel Rail Pressure (gauge) 
Intake Manifold Pressure 
Engine RPM 
Vehicle Speed 
Ignition Timing Advance 
Intake Air Temperature 
Air Flow Rate From MAF 
Absolute Throttle Position 
Time Since Engine Start 
Distance Traveled MIL On 
Fuel Rail Press Rel Manifold 
Fuel Rail Pressure 
Commanded EGR 
EGR Error 
Commanded Evap Purge 
Fuel Level Input 
Warm-ups Since DTCs Clrd 
Distance Since DTCs Clrd 
Evap System Vapor Press 
Barometric Pressure 
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Catalyst Temp B1-S1 
Catalyst Temp B2-S1 
Catalyst Temp B1-S2 
Catalyst Temp B2-S2 
Control Module Voltage 
Absolute Load Value 
Commanded Equival Ratio 
Relative Throttle Position 
Ambient Air Temperature 
Absolute Throttle Pos B 
Absolute Throttle Pos C 
Accelerator Pedal Pos D 
Accelerator Pedal Pos E 
Accelerator Pedal Pos F 
Command Throttle Actuator 
Minutes Run with MIL On 
Time Since DTCs Cleared 
Alcohol Fuel Percentage 
Absolute Evap Vapor Pres 
Evap System Vapor Pres 

HV Battery 
Calculated Load 
Engine Coolant Temp 
Fuel Rail Pressure (gauge) 
Intake Manifold Pressure 
Engine RPM 
Vehicle Speed 
Ignition Timing Advance 
Intake Air Temperature 
Air Flow Rate From MAF 
Absolute Throttle Position 
Time Since Engine Start 
Distance Traveled MIL On 
Fuel Rail Press Rel Manifold 
Fuel Rail Pressure 
Commanded EGR 
EGR Error 
Commanded Evap Purge 
Fuel Level Input 
Warm-ups Since DTCs Clrd 
Distance Since DTCs Clrd 
Evap System Vapor Press 
Barometric Pressure 
Catalyst Temp B1-S1 
Catalyst Temp B2-S1 
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Catalyst Temp B1-S2 
Catalyst Temp B2-S2 
Control Module Voltage 
Absolute Load Value 
Commanded Equival Ratio 
Relative Throttle Position 
Ambient Air Temperature 
Absolute Throttle Pos B 
Absolute Throttle Pos C 
Accelerator Pedal Pos D 
Accelerator Pedal Pos E 
Accelerator Pedal Pos F 
Command Throttle Actuator 
Minutes Run with MIL On 
Time Since DTCs Cleared 
Alcohol Fuel Percentage 
Absolute Evap Vapor Pres 
Evap System Vapor Pres 
 

Bit Encoded Values (CAN Bus) 
Bit encoded values are single bit values translated as On or Off, Complete or Not Complete, 
etc… 

Engine EFI / CCS 
Malfunction Indicator Lamp (MIL) 
Misfire Monitoring 
Fuel System Monitoring 
Comprehensive Component 
Compression Ignition 
Misfire Monitoring Ready 
Fuel System Monitoring Ready 
Comprehensive Component Ready 
Catalyst Monitoring 
Heated Catalyst Monitoring 
Evaportive System Monitoring 
Secondary Air System Monitoring 
Oxygen Sensor Monitoring 
Oxygen Sensor Heater Monitoring 
EGR and/or VVT System Monitoring 
NMHC Catalyst Monitoring 
NOx Aftertreatment Monitoring 
Boost Pressure System Monitoring 
Exhaust Gas Sensor Monitoring 
PM Filter Monitoring 
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EGR and/or VVT System Monitoring 
Catalyst Monitoring Ready 
Heated Catalyst Monitoring Ready 
Evaporative System Monitoring Ready 
Secondary Air System Monitoring Ready 
Oxygen Sensor Monitoring Ready 
Oyxgen Sensor Heater Monitoring Ready 
EGR and/or VVT System Monitoring Ready 
NMHC Monitoring Ready 
NOx Aftertreatment Monitoring Ready 
Boost Pressure System Monitoring Ready 
Exhaust Gas Sensor Monitoring Ready 
PM Filter Monitoring Ready 
EGR and/or VVT System Monitoring Ready  
Misfire Monitoring Enabled 
Fuel System Monitoring Enabled 
Comprehensive Component Monitoring Enabled 
Compression Ignition Monitoring Supported 
Misfire Monitoring Ready 
Fuel System Monitoring Ready 
Comprehensive Component Monitoring Ready 
Catalyst Monitoring Enabled 
Heated Catalyst Monitoring Enabled 
Evaporative System Monitoring Enabled 
Secondary Air System Monitoring Enabled 
Oxygen Sensor Monitoring Enabled 
Oxygen Sensor Heater Monitoring Enabled 
EGR and/or VVT System Monitoring Enabled 
NMHC Catalyst Monitoring Enabled 
NOx Aftertreatment Monitoring Enabled 
Boost Pressure System Monitoring Enabled 
Exhaust Gas Sensor Monitoring Enabled 
PM Filter Monitoring Enabled 
EGR and/or VVT System Monitoring Enabled 
Catalyst Monitoring Ready 
Heated Catalyst Monitoring Ready 
Evaporative System Monitoring Ready 
Secondary Air System Monitoring Ready 
Oxygen Sensor Monitoring Ready 
Oxygen Sensor Heater Monitoring Ready 
EGR and/or VVT System Monitoring Ready 
NMHC Monitoring Ready 
NOx Aftertreatment Monitoring Ready 
Boost Pressure System Monitoring Ready 
Exhaust Gas Sensor Monitoring Ready 
PM Filter Monitoring Ready 
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EGR and/or VVT System Monitoring Ready  
ECT Lockup 
Engine Independently Control Operation 
Request Warm-Up 
Racing Operation 
Engine Independently Operation 
Fuel Cut for Engine Stop Request 
ISC Learning 
Fuel Level  
Cruise Control Main Switch (Main CPU) 
Cruise Control Main Switch-Ready (Main CPU) 
Cruise Control Main Switch-Indication (Main CPU) 
Cruise Control 
Shift D Position 
Stop Light Switch-1 (Sub CPU) 
Stop Light Switch-2 (Sub CPU) 
Stop Light Switch (Main CPU) 
RES/ACC Switch 
SET/COAST Switch 
Cancel Switch  
System Guard 
Open Side Malfunction 
Actuator Power Supply 
ST1 
Throttle Motor 
Electromagnetic Clutch 
ETCS Actuator Power 
Accelerator IDL POS 
Throttle IDL POS 
Fail Safe Drive 
Fail Safe Drive (Main CPU)  
Shift Switch Status (L Range) 
Shift Switch Status (2 Range) 
Shift Switch Status (R Range) 
Pattern Switch Status 
Overdrive Cut Switch No. 2 Status 
Kick Down Switch Status 
Shift Switch Status (P Range) 
Overdrive Cut Switch No. 1 Status 
Shift Switch Status (3 Range) 
Shift Switch Status (4 or D Range) 
Shift Switch Status (D Range) 
Snow Switch Status 
Sports Mode Selection Switch 
Sports Shift Down Switch 
Sports Shift Up Switch 
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Shift Switch Status (N Range) 
Shift Switch Status (B Range) 
SD Switch 
TPS 1 Switch 
TPS 2 Switch 
TPS 3 Switch  
Lock Up Solenoid Status 
ST Solenoid Status 
Lockup 
Solenoid (DSU) 
SLN Solenoid Status 
SLU Solenoid Status 
SLT Solenoid Status 
Solenoid (SLC) 
Solenoid (SLS) 
Solenoid (DS1) 
Solenoid (DS2) 
AT Fluid 
G Sensor Calibration 
OXS1 Test 
OXS2 Test 
Misfire Test 
AS Test 
NSW Test 
SPD Test 
Check Mode 
A/F Sensor Test Results (Bank 1) 
A/F Sensor Test Results (Bank 2) 
O2 Sensor After HC Adsorber & Catalyst (Bank 1) 
O2 Sensor After HC Adsorber & Catalyst (Bank 2) 
Starter Control 
Power Steering Switch 
Stop Light Switch 
Electrical Load Switch 
Neutral Position Switch Signal 
A/C Signal 
Closed Throttle Position Switch 
Starter Signal 
FC TAU 
Idle Fuel Cut 
AI Operation Prohibit 
Power Steering Signal 
Diesel Throttle Learning Status 
EGR Learning Status 
Engine Oil Pressure Switch 
Throttle Open Switch 
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Fuel Lid Switch 
Fuel Lid 
Brake Switch 
Brake Switch Status 
Starter Relay 
Accessory Relay 
VVTL OCV Operation Duty 
VVTL Oil Pressure Switch 
VVTL 
OXS1 Test 
OXS2 Test 
Misfire Test 
AS Test 
NSW Test 
SPD Test 
Check Mode 
ACT VSV 
VSV Status For Variable Intake Control 
VSV Status For Fuel Pressure Up 
EGR 
ACIS VSV 
Fuel Pump Speed Control Status 
VSV Status For Secondary Air Control 
VSV Status For Swirl Control Valve 
Fuel Pump / Speed Status 
A/C Magnetic Clutch Relay 
EVAP Purge VSV 
VVT Control Status (Bank 2) 
Intake Air control VSV 
VVT Control Status (Bank 1) 
VSV Status For Intake Air Control 
Canister Control VSV 
Tank Bypass VSV 
VVTL System (Bank 1) 
VVTL System (Bank 2) 
AICV VSV 
Electric Fan Motor 
EVAP System Vent Value 
Vacuum Pump 
TC and TE1 
ACM Inhibit 
Fuel Shutoff Value For Delivery Pipe 
Regulator Shut Valve 
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ECT 
Shift Switch Status (R Range) 
Pattern Switch Status 
Shift Switch Status (D Range) 
Snow Switch Status 
Sports Mode Selection Switch 
Sports Shift Down Switch 
Sports Shift UP Switch  
Lock Up Solenoid Status 
SLU Solenoid Status 
SLT Solenoid Status  
SPD Test 
Check Mode  
Stop Light Switch 

HV ECU / CCS 
Loading Condition 
Engine Warming Up Request 
Air-Conditioning Request 
HCAC OBD Request 
Main Battery Charging Request 
Engine Idling Request 
Engine Stop Request 
System Main RElay Status - Cont3 
System Main RElay Status - Cont2 
System Main RElay Status - Cont1 
Converter Carrier Frequency 
Smart Key Status 
Air-Conditioning Gate Status 
Converter Gate Status 
MG2 Gate Status 
MG1 Gate Status  
Cruise Control 
Stop Switch 
Engine Warming Up Request 
Main Battery Charging Request 
Engine Fuel Cut 
Engine Idling Request 
Engine Stop Request  
Cruise Control 
Stop Switch 
Engine Warming Up Request 
Main Battery Charging Request 
Engine Fuel Cut 
Engine Idling Request 
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Engine Stop Request  
Cruise Control 
Stop Switch 
Engine Warming Up Request 
Main Battery Charging Request 
Engine Fuel Cut 
Engine Idling Request 
Engine Stop Request  
Cruise Control 
Stop Switch 
Engine Warming Up Request 
Main Battery Charging Request 
Engine Fuel Cut 
Engine Idling Request 
Engine Stop Request  
Cruise Control 
Stop Switch 
Engine Warming Up Request 
Main Battery Charging Request 
Engine Fuel Cut 
Engine Idling Request 
Engine Stop Request  
Cruise Control Main Switch (Main CPU) 
Cruise Control Main Switch-Ready (Main CPU) 
Cruise Control Main Switch-Indication (Main CPU) 
Cruise Control 
Shift D Position 
Stop Light Switch-1 (Sub CPU) 
Stop Light Switch-2 (Sub CPU) 
Stop Light Switch (Main CPU) 
RES/ACC Switch 
SET/COAST Switch 
Cancel Switch 

HV Battery 
Malfunction Indicator Lamp (MIL) 
Misfire Monitoring 
Fuel System Monitoring 
Comprehensive Component 
Compression Ignition 
Misfire Monitoring Ready 
Fuel System Monitoring Ready 
Comprehensive Component Ready 
Catalyst Monitoring 
Heated Catalyst Monitoring 
Evaportive System Monitoring 
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Secondary Air System Monitoring 
Oxygen Sensor Monitoring 
Oxygen Sensor Heater Monitoring 
EGR and/or VVT System Monitoring 
NMHC Catalyst Monitoring 
NOx Aftertreatment Monitoring 
Boost Pressure System Monitoring 
Exhaust Gas Sensor Monitoring 
PM Filter Monitoring 
EGR and/or VVT System Monitoring 
Catalyst Monitoring Ready 
Heated Catalyst Monitoring Ready 
Evaporative System Monitoring Ready 
Secondary Air System Monitoring Ready 
Oxygen Sensor Monitoring Ready 
Oyxgen Sensor Heater Monitoring Ready 
EGR and/or VVT System Monitoring Ready 
NMHC Monitoring Ready 
NOx Aftertreatment Monitoring Ready 
Boost Pressure System Monitoring Ready 
Exhaust Gas Sensor Monitoring Ready 
PM Filter Monitoring Ready 
EGR and/or VVT System Monitoring Ready  
Misfire Monitoring Enabled 
Fuel System Monitoring Enabled 
Comprehensive Component Monitoring Enabled 
Compression Ignition Monitoring Supported 
Misfire Monitoring Ready 
Fuel System Monitoring Ready 
Comprehensive Component Monitoring Ready 
Catalyst Monitoring Enabled 
Heated Catalyst Monitoring Enabled 
Evaporative System Monitoring Enabled 
Secondary Air System Monitoring Enabled 
Oxygen Sensor Monitoring Enabled 
Oxygen Sensor Heater Monitoring Enabled 
EGR and/or VVT System Monitoring Enabled 
NMHC Catalyst Monitoring Enabled 
NOx Aftertreatment Monitoring Enabled 
Boost Pressure System Monitoring Enabled 
Exhaust Gas Sensor Monitoring Enabled 
PM Filter Monitoring Enabled 
EGR and/or VVT System Monitoring Enabled 
Catalyst Monitoring Ready 
Heated Catalyst Monitoring Ready 
Evaporative System Monitoring Ready 
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Secondary Air System Monitoring Ready 
Oxygen Sensor Monitoring Ready 
Oxygen Sensor Heater Monitoring Ready 
EGR and/or VVT System Monitoring Ready 
NMHC Monitoring Ready 
NOx Aftertreatment Monitoring Ready 
Boost Pressure System Monitoring Ready 
Exhaust Gas Sensor Monitoring Ready 
PM Filter Monitoring Ready 
EGR and/or VVT System Monitoring Ready  
Cooling Fan Stop Control Request 
Equal Transaction Charge Permit Signal 
Equal Charge Out Relay Signal 
Charge Control Signal 

State Encoded Values (CAN Bus) 

EFI (state) 
Received MIL From ECT 
Transmission Type 
System Identification 
Shift Status 
VNT Type 
DPNR Status (S) 
Combustion Status (D4) 

ECT 
Transmission Type 
System Identification 
Shift Status 

HV 
MG2 Carrier Frequency 
MG2 Control Mode 
MG1 Carrier Frequency 
MG1 Control Mode 
ECU Control Mode 

Live Data Sensors (non-CAN bus) 

Engine EFI 
Calculated Load 
Engine Coolant Temp 
Fuel Rail Pressure (gauge) 
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Intake Manifold Pressure 
Engine RPM 
Vehicle Speed 
Ignition Timing Advance 
Intake Air Temperature 
Air Flow Rate From MAF 
Absolute Throttle Position 
Time Since Engine Start 
Distance Traveled MIL On 
Fuel Rail Press Rel Manifold 
Fuel Rail Pressure 
Battery 
Injector 
Revised Injection Volume 
Fuel FB Coef 
A/F Learn 
Purge Learn 
KCS Feedback 
KCS Feedback 
Fuel Pressure 
Injector 
IAC Step Position 
IAC Duty Ratio 
EGRT Gas 
E-ABV Step Position 
Engine Run Time 
EGR Valve Position 
SPD (SP2) 
SPD (NC0) 
SPD (NC2) 
SPD (NC) 

ABS 
Throttle Sensor 
Sub Throttle Sensor 
Engine RPM 
Vehicle Speed 
Steering Angle 
Master Pressure Sensor 
Stroke Sensor 
Vehicle Speed (for EMPS) 

TPWS 
Vehicle Speed 
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AC 
Room Temperature Sensor 
Ambient Temperature Sensor 
Evaporative Temperature Sensor 
Solar Sensor (D Side) 
Solar Sensor (P Side) 
Engine Coolant Temperature 
Duct Sensor (D Side) 
Duct Sensor (P Side) 
Set Temperature (D Side) 
Set Temperature (P Side) 
Air Mix Damper Position (D Side) 
Air Mix Damper Position (P Side) 
Air Outlet Damper Position 
Air Inlet Damper Position 
Cool Air Bypass Damper Position (D Side) 
Cool Air Bypass Damper Position (P Side) 
Air Mix Damper Target Position (D Side) 
Air Mix Damper Target Position (P Side) 
Air Outlet Damper Target Position 
Air Inlet Damper Target Position 
Air Mix Servo Motor Target Step (D Side) 
Air Mix Servo Motor Target Step (P Side) 
Air Outlet Servo Motor Target Step (D Side) 
Air Outlet Servo Motor Target Step (P Side) 
Blower Motor Speed Level 
Adjusted Ambient Temperature 
+B Abnormal Low Voltage Counter 
Emission Gas Sensor 
Rear Solar Sensor 
Emission Gas NOx Sensor 
Regulator Pressure Current 
Filter Flow Volume 
Regulator Control Current 
Room Temperature Sensor (Rear) 
Ambient Temperature Sensor (Rear) 
Set Temperature (Rear) 
Air Mix Damper Position (Rear) 
Air Outlet Mode Damper Position (Rear) 
Air Mix Target Position (Rear) 
Air Outlet Target Position (Rear) 
Blower Motor Speed Level (Rear) 
Humidity Sensor 
Air Mix Servo Motor Target Pulse (D Side) 
Air Mix Servo Motor Target Pulse (P Side) 

 

38 Supported Parameters   



 

Air Outlet Servo Motor Target Pulse (D Side) 
Air Inlet Damper Target Pulse 
Cool Air Bypass Pulse 
Compressor Speed 
Compressor Target Speed 
Evaporator Fin Thermistor 
Number of Trouble Codes 

EFI  
Cyl 1 Misfire Rate 
Cyl 2 Misfire Rate 
Cyl 3 Misfire Rate 
Cyl 4 Misfire Rate 
Cyl 5 Misfire Rate 
Cyl 6 Misfire Rate 
Cyl 7 Misfire Rate 
Cyl 8 Misfire Rate 

CCS / Immobiliser  
Short Term Fuel Trim B1 
Short Term Fuel Trim B3 
Long Term Fuel Trim B1 
Long Term Fuel Trim B3 
Short Term Fuel Trim B2 
Short Term Fuel Trim B4 
Long Term Fuel Trim B2 
Long Term Fuel Trim B4 
O2 Sensor B1-S1 
Short Fuel Trim B1-S1 
O2 Sensor B1-S2 
Short Fuel Trim B1-S2 
O2 Sensor B1-S3 
Short Fuel Trim B1-S3 
O2 Sensor B1-S4 
Short Fuel Trim B1-S4 
O2 Sensor B2-S1 
Short Fuel Trim B2-S1 
O2 Sensor B2-S2 
Short Fuel Trim B2-S2 
O2 Sensor B2-S3 
Short Fuel Trim B2-S3 
O2 Sensor B2-S4 
Short Fuel Trim B2-S4 
Equivalence Ratio B1-S1 
O2 B1-S1 Wide Range V 
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Equivalence Ratio B1-S2 
O2 B1-S2 Wide Range V 
Equivalence Ratio B1-S3 
O2 B1-S3 Wide Range V 
Equivalence Ratio B1-S4 
O2 B1-S4 Wide Range V 
Equivalence Ratio B2-S1 
O2 B2-S1 Wide Range V 
Equivalence Ratio B2-S2 
O2 B2-S2 Wide Range V 
Equivalence Ratio B2-S3 
O2 B2-S3 Wide Range V 
Equivalence Ratio B2-S4 
O2 B2-S4 Wide Range V 
IACV Position 
IACV Open Stuck 
IACV CLS Stuck 
Accelerator Pos 1 
Accelerator Pos 2 
Throttle Pos 2 
Throttle Request Pos 
Throttle Motor Opening Duty Ratio 
Throttle Motor Closing Duty Ratio 
Throttle Fully Closed Learning 
Accelerator Fully Closed Learning 
Throttle Motor Current 
Electromagnetic Clutch Current 
Fuel Tank Pressure 
Target Cam Phaser 
Cam Phaser 
OCV Duty Ratio 
Total FT 1 
Total FT 2 
O2 LR B1 S1 
O2 LR B2 S1 
O2 RL B1 S1 
O2 RL B1 S2 
O2 RL B2 S1 
O2 RL B2 S2 
Cruise Control Vehicle Speed 
Cruise Control Memory Vehicle Speed 
Cruise Control Throttle Opening Angle 
Registered Key Number 

CCS / Immobiliser 
Cruise Control Vehicle Speed 
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Cruise Control Memory Vehicle Speed 
Cruise Control Throttle Opening Angle 
Registered Key Number 

Stop and Go 
Starter Operation # 
Engine Speed (EFI ECU) 
Engine Speed (NE Signal) 
Vehicle Speed (EFI ECU) 
Vehicle Speed (Speed Signal) 
Battery Current 
Battery Voltage 
Brake Booster Pressure 
Vacuum For Brake 
CRC Stroke Sensor 
Coolant Temp 
Ambient Temp Sensor 
Multiple Current (1 Trip) 
Multiple Current (30 Min) 
Cranking Time 
Coolant Temp (Cranking) 
Min Voltage (Cranking) 
Learning Volt (CRC Lo) 
Learning Volt (CRC Up) 

Sequential MT 
Calculated Load 
Engine Coolant Temp 
Engine Revolution 
Vehicle Speed 
Intake Air Temperature 
Throttle Absolute Position 
Driving Mileage After Malfunction 
Backup Engine Speed 
Accelerator Pedal Angle 
Theoretical Engine Torque 
Driver Demand Torque 
Engine Loss Torque 
Idle Set Speed 
Requested Engine Torque 
Requested Engine Speed 
Gear Indicator Pos (except R & N) 
Gear Indicator Pos (R & N) 
Buzzer Output Status 
Clutch Position (Current) 
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Clutch Position (Target) 
Shift Position (Current) 
Shift Position (Target) 
Select Position (Current) 
Select Position (Target) 
Shift Pressure 
Accumulate Pressure 
Clutch Solenoid Current 
Master Solenoid Current 
Shift Solenoid Current 
Select Solenoid Current 
Wheel Speed FR 
Wheel Speed FL 
Wheel Speed RR 
Wheel Speed RL 
T/M Input Shaft Speed 
Clutch Solenoid Null Position 
Master Solenoid Null Position 
Shift Solenoid Null Position 
Select Solenoid Null Position 
Clutch Touch Position 
Clutch Clamp Position 
Clutch Coast Position 
Neutral Position (Shift Position) 
Neutral Position (Select Position) 
1st Gear Position (Shift Position) 
1st Gear Position (Select Position) 
2nd Gear Position (Shift Position) 
2nd Gear Position (Select Position) 
3rd Gear Position (Shift Position) 
3rd Gear Position (Select Position) 
4th Gear Position (Shift Position) 
4th Gear Position (Select Position) 
5th Gear Position (Shift Position) 
5th Gear Position (Select Position) 
Reverse Gear Position (Shift Position) 
Reverse Gear Position (Select Position) 
Cold Condition Judgment 
1st Drive Gear Teeth Number 
1st Driven Gear Teeth Number 
2nd Drive Gear Teeth Number 
2nd Driven Gear Teeth Number 
3rd Drive Gear Teeth Number 
3rd Driven Gear Teeth Number 
4th Drive Gear Teeth Number 
4th Driven Gear Teeth Number 
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5th Drive Gear Teeth Number 
5th Driven Gear Teeth Number 
Final Drive Gear Teeth Number 
Final Driven Gear Teeth Number 
Reverse Drive Gear Teeth Number 
Reverse Driven Gear Teeth Number 
6th Gear Position (Shift Position) 
6th Gear Position (Select Position) 
Trouble Codes 

T/M Control 
BATT Voltage 
IG (+B) Voltage Value 
U Phase Voltage Value 
V Phase Voltage Value 
W Phase Voltage Value 
Detail Information 1 
Detail Information 2 
Detail Information 3 
PSW Indicator Mode 
Number Of Trip Counter After Learning 
Fuel Rank 
Type Of ECU 

ABS 
Front Right Wheel Speed 
Front Left Wheel Speed 
Rear Right Wheel Speed 
Rear Left Wheel Speed 
Deceleration Sensor GL1 
Deceleration Sensor GL2 
Yaw Rate Sensor 
Yaw Zero Point 
Output Value of GL1 
Output Value of GL2 
Front Right Wheel Speed 
Front Left Wheel Speed 
Rear Right Wheel Speed 
Rear Left Wheel Speed 
VSP1 Vehicle Speed On Meter 
Front Right Wheel Speed 
Front Left Wheel Speed 
Rear Right Wheel Speed 
Rear Left Wheel Speed 
VSP1 Vehicle Speed On Meter 
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GL1 Sensor 
GL2 Sensor 
Vacuum Sensor 1 
Vacuum Sensor 2 
Master Cylinder Pressure 1 
Master Cylinder Pressure 2 
Master Cylinder Pressure 
Regulator Pressure 
Front Pressure 
Rear Pressure 
Regeneration Request Torque 
Regeneration Operation Torque 
ECB SLAFR Solenoid Current 
ECB SLAFL Solenoid Current 
ECB SLARR Solenoid Current 
ECB SLARL Solenoid Current 
ECB SLRFR Solenoid Current 
ECB SLRFL Solenoid Current 
ECB SLRRR Solenoid Current 
ECB SLRRL Solenoid Current 
ECB Stroke Sensor 
ECB Stroke Sensor 2 
ECB Accumulator Pressure 1 
ECB Accumulator Pressure 2 
ECB Front Right Pressure 
ECB Front Left Pressure 
ECB Rear Right Pressure 
ECB Rear Left Pressure 
Regenerative Request Torque (FR) 
Regenerative Request Torque (FL) 
Regenerative Request Torque (RR) 
Regenerative Request Torque (RL) 
Master Cylinder Pressure 1 
Master Cylinder Pressure 2 
Accumulator Pressure 
Diff Degree of Present Accelerator 
Diff % of Present Accelerator 
Real Output Torque 
Diff % of Present Throttle 
Number IG ON After Enter Inspection Mode 
Number of IG On 
Vehicle Speed 
Steering Angle 
Yaw Rate Sensor 
Master Cylinder Pressure 
Stroke Sensor 
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Throttle Opening Angle 
Master Cylinder Pressure Grade 
Stroke Sensor Grade 
Right and Left G 
Back and Forth G 
Vehicle Speed Grade 
Diff % of Present Accelerator 
FR Wheel Cylinder Pressure 
FL Wheel Cylinder Pressure 
RR Wheel Cylinder Pressure 
RL Wheel Cylinder Pressure 
Accumulator Pressure 
Master Cylinder Pressure 2 
Stroke Sensor 2 
MTT 
Voltage Value of IG1 
Voltage Value of IG2 
BS1 
BS2 
VM1 
VM2 
+B1 
+B2 
Elapsed Time After Ignition Switch ON 
Target Oil Pressure (FR) 
Target Oil Pressure (FL) 
Target Oil Pressure (RR) 
Target Oil Pressure (RL) 
Current of SLAFR Solenoid 
Current of SLAFL Solenoid 
Current of SLARR Solenoid 
Current of SLARL Solenoid 
Current of SLRFR Solenoid 
Current of SLRFL Solenoid 
Current of SLRRR Solenoid 
Current of SLRRL Solenoid 
Front Right Wheel Speed 
Front Left Wheel Speed 
Rear Right Wheel Speed 
Rear Left Wheel Speed 
Detailed Code for Freeze DTC 
ABS Trouble Codes 

TPWS (Tire Pressure) 
ID1 Tire Inflation Pressure 
ID2 Tire Inflation Pressure 
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ID3 Tire Inflation Pressure 
ID4 Tire Inflation Pressure 
ID1 Temperature In Tire 
ID2 Temperature In Tire 
ID3 Temperature In Tire 
ID4 Temperature In Tire 
ID1 Battery Voltage 
ID2 Battery Voltage 
ID3 Battery Voltage 
ID4 Battery Voltage 
ID1 Tire Inflation Pressure 
ID2 Tire Inflation Pressure 
ID3 Tire Inflation Pressure 
ID4 Tire Inflation Pressure 
ID5 Tire Inflation Pressure 
ID1 Temperature In Tire 
ID2 Temperature In Tire 
ID3 Temperature In Tire 
ID4 Temperature In Tire 
ID5 Temperature In Tire 
ID1 Initial Threshold Of Low Pressure 
ID2 Initial Threshold Of Low Pressure 
ID3 Initial Threshold Of Low Pressure 
ID4 Initial Threshold Of Low Pressure 
ID5 Initial Threshold Of Low Pressure 
TPWS Trouble Codes 

EHPS / EMPS 
Torque Sensor 1 Output 
Torque Sensor 2 Output 
Torque Sensor Control 
Meter Vehicle Velocity 
Wheel Speed (Right) 
Wheel Speed (Left) 
Engine Revolution 
Motor Actual Current 
Command Value Current 
Steering Wheel Angle Velocity 
Thermistor Temperature 
PIG Power Supply 
IG Power Supply 
TRQ1 Zero Point Value 
TRQ2 Zero Point Value 
TRQ3 Zero Point Value 
Motor Terminal Voltage (+) 
Motor Terminal Voltage (-) 
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Control Mode 
IG On/Off Times 
Motor Hi Power Record 
Number of Trouble Codes 
ROM Version (CAR) 
ROM Version (Major Version) 
ROM Version (Minor Version) 
Assist Map Select State 
Ready Status 

VGRS 
Steering Position 1 (Parallel) 
Steering Position 2 (Serial) 
Vehicle Speed (Vsc ECU) 
Wheel Speed (Right) 
Wheel Speed (Left) 
Motor Power Source Current 
Estimated Motor Current 
Actuator Position 
Steering Angle Velocity 
Lock Motor Output Volt 
Thermistor Temperature 
PIG-Power Source Volt 
IG-Power Source Volt 
Actuator Target Angle 
Actuator Revolution Speed 
Command Value Duty 
Motor Estimated Current 
Actuator Lock Duty Value 
Terminal Voltage U 
Terminal Voltage V 
Terminal Voltage W 
Actuator Deviation Angle 
Actuator Estimate Temp 

AIRSUS & AHC  
FR Wheel Height 
FL Wheel Height 
R Wheel Height 
Front Pressure Sensor 
Rear Pressure Sensor 
Accumulator Pressure Sensor 
Vehicle Speed 
FR Wheel Speed 
FL Wheel Speed 
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IG Voltage 
+B Voltage 
Steering Angle 
Steering Angle 
Engine Speed 
Oil Temperature Sensor 
Front Damper Step 
Rear Damper Step 
G (Back & Forth) Sensor 
G (Up and Down) Sensor FR 
G (Up and Down) Sensor FL 
G (Up and Down) Sensor Rear 
FR Height Control Sensor 
FL Height Control Sensor 
RR Height Control Sensor 
RL Height Control Sensor 
Damper Step FR 
Damper Step FL 
Damper Step RR 
Damper Step RL 
Wheel Speed FR 
FR Height Adjust 
FL Height Adjust 
RR Height Adjust 
RL Height Adjust 
FR After Height Adjust 
FL After Height Adjust 
RR After Height Adjust 
RL After Height Adjust 
RR Wheel Speed 
RL Wheel Speed 
AHC Trouble Codes 
Max Damper Step FR 
Max Damper Step FL 
Max Damper Step RR 
Max Damper Step RL 

BODY 
Illumination Rate Information 
Shoulder Belt Position 1 
Shoulder Belt Position 2 
Shoulder Belt Position 3 

BODY No2 
Illumination Rate Information 
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Shoulder Belt Position 1 
Shoulder Belt Position 2 
Shoulder Belt Position 3 

Steering Pad 
Rheostat Signal 

SRS 
SRS Trouble Codes 

OCC (occupant detect) 
FL Sensor Voltage 
FR Sensor Voltage 
RL Sensor Voltage 
RR Sensor Voltage 
FL Sensor Weight 
FR Sensor Weight 
RL Sensor Weight 
RR Sensor Weight 
Total Sensor Weight 
OCC Trouble Codes 
OCC Past Trouble Codes 

Meter 
Speed Meter 
Tachometer 
Input Value Of Fuel Gauge 
Input Value Of Light Rheostat 
Tube Temperature 
Input Value Of Oil Gauge 
Output Value Of Sub Fuel Gauge 

AFS 
+B 
Height Sensor Power Supply 
Front Height Sensor Signal 
Rear Height Sensor Signal 
Steering Sensor Signal 
Steering Sensor Center Position 
Left Swivel Motor Position Sensor 
Right Swivel Motor Position Sensor 
AFS Trouble Codes 
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P-Seat 
ECU IG Power Voltage 
Current Slide Position 
Current Reclining Position 
Current Front Vertical Position 
Current Lifter Position 
Current Headrest Position 
Memorized Slide Position 1 
Memorized Reclining Position 1 
Memorized Front Vertical Position 1 
Memorized Lifter Position 1 
Memorized Headrest Position 1 
Memorized Slide Position 2 
Memorized Reclining Position 2 
Memorized Front Vertical Position 2 
Memorized Lifter Position 2 
Vehicle Speed 

D-Door 
Mirror Position Sensor (Vertical) 
Mirror Position Sensor (Horizontal) 

P-Door 
Mirror Position Sensor (Vertical) 
Mirror Position Sensor (Horizontal) 

Tilt and Telescope 
T&T Manual Switch Data 
Power Source Voltage 
Tilt Position (Pulse) 
Telesco Position (Pulse) 
Tilt Position (Analog) 
Telesco Position (Analog) 
SB Position 
Tilt Return Position 
Telesco Return Position 
Tilt Up Limit Position 
Tilt Down Limit Position 
Telesco Short Limit Position 
Telesco Long Limit Position 
Tilt Memory Position 1 
Telesco Memory Position 1 
Tilt Memory Position 2 
Telesco Memory Position 2 
SB Memory Position 2 
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Tilt Return Position 
Telesco Return Position 
Tilt Up Limit Position 
Tilt Down Limit Position 
Telesco Short Limit Position 
Telesco Long Limit Position 
Tilt Memory Position 1 
Telesco Memory Position 1 
Tilt Memory Position 2 
Telesco Memory Position 2 
Mirror Manual Select 
Freeze Speed Information 
Tilt Memory Position 3 
Telesco Memory Position 3 
ECU IG Power Voltage 
Current Slide Position 
Current Reclining Position 
Current Front Vertical Position 
Current Lifter Position 
Current Headrest Position 
Memorized Slide Position 1 
Memorized Reclining Position 1 
Memorized Front Vertical Position 1 
Memorized Lifter Position 1 
Memorized Headrest Position 1 
Memorized Slide Position 2 
Memorized Reclining Position 2 
Memorized Front Vertical Position 2 
Memorized Lifter Position 2 
Memorized Headrest Position 2 
Memorized Driver Mirror Position 1 
Memorized Passenger Mirror Position 1 
Memorized Driver Mirror Position 2 
Memorized Passenger Mirror Position 2 
Vehicle Speed 
Memorized Cushion Position 1 
Memorized Cushion Position 2 
Memorized Slide Position 3 
Memorized Reclining Position 3 
Memorized Front Vertical Position 3 
Memorized Lifter Position 3 
Memorized Headrest Position 3 
Memorized Cushion Position 3 
Memorized Driver Mirror Position 3 
Memorized Driver Mirror Position 3 
Memorized Passenger Mirror Position 1 
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Memorized Belt Anchor Position 1 
Memorized Belt Anchor Position 2 
Memorized Belt Anchor Position 3 
Slide Front Most Position 
Headrest Down Most Position 
Current Cushion Position 

MIRROR, MIRROR-R 
Driver Side Mirror Position Vertical Sensor 
Driver Side Mirror Position Horizontal Sensor 
Passenger Side Mirror Position Vertical Sensor 
Passenger Side Mirror Position Horizontal Sensor 
Mirror Position Sensor Vertical 
Mirror Position Sensor Horizontal 

Combination Switch 
Wiper Volume Position 

SMART KEY 
Power Save Counter - 10 Minutes 
Power Save Counter - 5 Days 
Power Save Counter - 14 Days 

Immobiliser 
Registered Key Number 

MIRROR-L 
Mirror Position Sensor Vertical 
Mirror Position Sensor Horizontal 

 Bitmap Encoded Values (non-CAN Bus) 

Engine EFI 
Engine Run Permission 
Engine Warm Up Signal 
Acc Racing Signal 
Engine Run Signal 
RAM Monitor 
ATF 
Throttle Motor 
Electromagnetic Clutch 
ETCS Actuator Power 
Accel Idle Pos 
Throttle Idle Pos 
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Fail Safe Drive 
Fail Safe Drive (Main CPU)  
Lock Up Solenoid  
Status Of EVAP Auto Test (Mode 8) 
Status Of EVAP Auto Test (Mode 8) 
Status Of EVAP Auto Test (Mode 8) 
PS Oil Pressure Switch 
Stop Light Switch 
Elect Load Signal 
PNP Switch 
A/C Signal 
CTP Switch 
Starter Signal 
FC TAO 
FC IDL 
PS Signal 
Stop Light Switch 1 
Engine Stop Signal 
A/C Cut Signal 
Variable Intake VSV 
Fuel Pressure Up VSV 
EGR System 
Intake Control VSV 1 
Fuel Pump Relay 
Second Air VSV 
SCV VSV 
A/C Idle VSV 
Fuel Pump SPD 
Purge Cut VSV 
A/C Magnetic Clutch 
EVAP VSV 
Vapor Press VSV 
VVT Ctrl B2 
Intake Ctrl VSV2 
Supercharge Control Relay 
VVT Ctrl B1 
Boost Pressure VSV 
Auto Oil Supply 
Air Bleed VSV 
Int Air Ctrl VSV 
Exh Gas Ctrl VSV 
Exh Bypass VSV 
Canister Pressure Control VSV 
Tank Pressure Bypass VSV 
VVTL  Control (Bank 1) 
VVTL Control (Bank 2) 
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AICV 
Engine Cooling Fan 
Vent Valve 
Pump For EVAP System 
Low 
2nd 
Reverse 
Pattern Sel Switch (M) 
Overdrive Cut Switch 
Kickdown Switch 
Overdrive Cut Switch 1 
3rd 
4th/Drive 
Drive 
Snow Switch 
Sport Mode Selection Switch 
Sport Shift Down Switch 
Sport Shift Up Switch 
Solenoid (SLN) 
Solenoid (SLU) 
Solenoid (SLT) 
Solenoid (SLD) 
Solenoid (SLC) 
Solenoid (SLS) 
Solenoid (DSU) 

CCS 
Cruise Control Main Switch (Main CPU) 
Cruise Control Main Switch-Ready (Main CPU) 
Cruise Control Main Switch-Indicator (Main CPU) 
Cruise Control 
Shift D Position 
Stop Light Switch 1 (Sub CPU) 
Stop Light Switch 2 (Sub CPU) 
Stop Light Switch 2 (Main CPU) 
RES/ACC Switch 
SET/COAST Switch 
Cancel Switch 

Stop and Go 
MIL Status 
Clutch Lower Switch 
Clutch Upper Switch 
Neutral Switch 
1st and 2nd Switch 
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Reverse 
Engine Hood Switch 1 
Engine Hood Switch 2 
D Curtsey Switch Signal 
Cancel Switch 
Stop Light Switch 
Oil Pressure Switch 
Alternator L Terminal 
TC Terminal 
Starter Signal 
A/C Signal 
Starter Control Signal 
Eco Run Mode Indicator 
Eco Run Operate Indicator 
Indicator Lamp OIL 
Charge Lamp 
Buzzer 
Eco Run (Pre Condition) 
Eco Run (Vehicle Speed) 
Eco Run (Shift Cond) 
Eco Run (Clutch Cond) 
Eco Run (Idle Cond) 
Engine Start (Battery) 
Engine Start (Vacuum) 
Engine Start (Brake) 
Engine Start (Stop Cond) 
Engine Start (Moving) 
Engine Start (Shift Cond) 
P1642 (Engine ECU) 
P1642 (S&G) 
P0335 (Open) 
P0335 (Int) 
P0355 (Engine ECU) 
P0500 (Engine ECU) 
P0500 (Open) 
P1862 
P1855 
P1857 
P1780 (Open) 
P1780 (Short) 
P1870 (Open) 
P1870 (Short) 
P1871 (Open) 
P1871 (Short) 
P1540 
P1541 (Stop Cond) 
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P1541 (Spd) 
P1542 (Open/Short) 
P1542 (Output) 
P1543 
P1523 
P1520 (Short) 
P1520 (Open) 
P1520 (Engine ECU) 
P1643 
P1644 
P1544 
P1545 
P1115 
P1875 
P1642 (EFI) 
P1642 (Eco) 
P0335 (Open) 
P0335 (Int) 
P0355 (Engine ECU) 
P0500 (Engine ECU) 
P0500 (Open) 
P1862 
P1855 
P1857 
P1780 (Open) 
P1780 (Short) 
P1870 (Open) 
P1870 (Short) 
P1871 (Open) 
P1871 (Short) 
P1540 
P1541 (Stp) 
P1541 (Spd) 
P1542 (Open/Short) 
P1542 (Output) 
P1543 
P1523 
P1520 (Short) 
P1520 (Open) 
P1520 (Engine ECU) 
P1643 
P1644 
P1544 
P1545 
P1115 
P1875 
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P1642 (EFI) 
P1642 (Eco) 
P0335 (Open) 
P0335 (Int) 
P0355 (Engine ECU) 
P0500 (Engine ECU) 
P0500 (Open) 
P1862 
P1855 
P1857 
P1780 (Open) 
P1780 (Short) 
P1870 (Open) 
P1870 (Short) 
P1871 (Open) 
P1871 (Short) 
P1540 
P1541 (Stp) 
P1541 (Spd) 
P1542 (Open/Short) 
P1542 (Output) 
P1543 
P1523 
P1520 (Short) 
P1520 (Open) 
P1520 (Engine ECU) 
P1643 
P1644 
P1544 
P1545 
P1115 
P1875 
Fail Safe (Comm Fail 1) 
Fail Safe (Comm Fail 2) 
Fail Safe (Spd Sensor) 
Fail Safe (Cancel Switch) 
Fail Safe (Shift Switch Fail) 

Sequential MT 
MIL Status 
Clutch Fully Engaged 
Clutch Engaging 
Clutch Fully Disengaged 
Clutch Disengaged 
Changing Gear 
Torque Reduction Request 
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MIL Illumination 
Cruise Control Inhibit 
Invalid Position 
Reverse 
SAS Change Up 
SAS 
SAS Change Down 
Shift Lever Switch Signal 1 
Shift Level Switch Signal 2 
Shift Lever Switch Signal 3 
Shift Level Switch Signal 4 
Shift Lever Check Signal 3 
Shift Level Check Signal 4 
Shift Lever Check Signal 3 
Shift Level Check Signal 4 
Steering Switch Signal Up 
Steering Switch Signal Down 
CAN Communication 
Door Lamp 
Ignition Signal 
T/M Reverse Switch Signal 
Motor Pump Relay Signal 
T/M Neutral Switch Signal  
STP Switch Signal 
NSW Signal 
A/C Switch Signal 
IDL Switch Signal  
NSW Switch Signal 
SPD Switch Signal 
XTEST Switch Signal 

T/M Control 
Initial Drive Control Completed 
Completion Of Detecting Lock Position 
Completion Of Detecting Unlock Position 
Completion Of Learning Lock Position 
Completion Of Learning Unlock Position 
P/Not P Movable Shift Range 
Power Supply Off Preparation Request Signal 
Main Relay For Motor Drive 
U Phase Current-Carrying Status 
V Phase Current-Carrying Status 
W Phase Current-Carrying Status 
Main Relay 
Signal Of Electrical Key Condition 
Vehicle Condition 
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ACC Condition Signal 
BATT Voltage Status 
IG (+B) Phase Voltage Status 
U Phase Voltage Status 
V Phase Voltage Status 
W Phase Voltage Status 
Shift Position Display (P) 
Shift Position Display (not P) 
Master Caution Display 

ABS 
Solenoid Relay 
ABS Motor Relay 
TRAC Motor Relay 
Pre-Charge Pump 
Stop Light Switch 
Main Idle Switch 
Sub Idle Switch 
VSC/TRC Off Switch 
Hydro Booster High Pressure Switch 
Hydro Booster Low Pressure Switch 
Reservoir Level Switch 
FR 
FL 
RR 
RL 
SFRR 
SFRH 
SFRL 
SFLH 
SRRR (SRR) 
SRRH (SRH) 
SRLR 
SRLH 
SMFR 
SMFL 
SMR 
SPFR 
SPFL (SMV2) 
SRCF (SRC1) 
SRCR (SRC2) 
Test Mode Status 
Regeneration Cooperation Control 
1 System Brake 
SMC1 
SMC2 
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SS 
Solenoid Relay 
ABS Motor Relay 
H/B Motor Relay 
ECU IG Power Voltage 
Stop Light Switch 
SA1 Solenoid 
SA2 Solenoid 
Hydro Booster Low Pressure Switch 
Hydro Booster High Pressure Switch 
Test Mode Status  
SFRH 
SFRR 
SFLH 
SFLR 
SRRH (SRH) 
SRRR (SRR) 
SRLH 
SRLR 
Stop Light Switch 
Main Idle Switch 
Sub Idle Switch 
VSC/TRC Off Switch 
Hydro Booster High Pressure Switch 
Hydro Booster Low Pressure Switch 
PKB Switch 
Air Bleed Support 
Test Mode Status 
ECU Code 1 
ECU Code 2 
ECU Code 3 
ECU Code 4 
Solenoid Relay 
ABS Motor Relay 
H/B Motor Relay 
FR 
FL 
RR 
RL 
SFRH 
SFRR 
SFLH 
SFLR 
SRRH (SRH) 
SRRR (SRR) 
SRLH 
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SRLR 
SRCF (SA1, SRC1, SBAR) 
SRCR (SA2, SRC2, SBAL) 
SRMF (SMCF, SA3, SMC1) 
SRMR (SMCR, STR, SMC2) 
SMF (BA-SOL) 
SMR 
SPFR 
SPFL 
Step Force Switch 
Reservoir Level Switch 
PPS Solenoid 
SSC 
MC1 
MC2 
SC1 
SC2 
Main Relay 1 
Main Relay 2 
A Pattern Drive Is Under Enforcement 
Two Or More Frame For Freeze Frame Data 
Existence of VSC 
Brake Type 
Motor Relay 1 
Motor Relay 2 
Steering Sensor 
Deceleration Sensor 
Yaw Rate Sensor 
EFI Communication 
RL Speed Sensor 
RR Speed Sensor 
FL Speed Sensor 
FR Speed Sensor 
RL Wheel Cylinder Pressure 
RR Wheel Cylinder Pressure 
FL Wheel Cylinder Pressure 
FR Wheel Cylinder Pressure 
Stroke Sensor 2 
Stroke Sensor 1 
Master Cylinder Pressure 2 
Master Cylinder Pressure 1 
Accumulator Pressure 
HV Communication  
Inspection Mode 
Stop Light Switch 
VSC/TRC Off Switch 
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Park Brake Switch 
Reservoir Level Switch 
Buzzer 
Rear Right Wheel Direction 
Rear Left Wheel Direction 
Front Right Wheel Direction 
Front Left Wheel Direction 
Main Relay 1 for ECB 
Main Relay 2 for ECB 
Motor Relay 1 
Motor Relay 2 
SMC1 
SMC2 
SCSS 
Capacitor ModeTPWS (Tire Pressure) 
Initialization Switch Status 
Select Switch Status  
ID Code of Transmission Place  
ID Code of Transmission Status  
Initialization Switch Setting Information 
Select Switch Setting Information 

AIRSUS & AHC  
Height Control Switch (Down) 
Height Control Switch (Up) 
Height Control Hold Switch 
Stop Light Switch 
Door Switch 
Height Switch Hold 
Height Switch Up 
Height Switch Down 
Damping Force Switch 1 
Damping Force Switch 2 
MOD2 
Height Control Switch 
TD Terminal 
Access Mode Switch 
Rear Leveling Solenoid 
Rear Gate Solenoid 
Front Leveling Solenoid 
Front Gate Solenoid 
Accumulator Solenoid 
Motor Relay 
Main Relay 
Main Relay Monitor 
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Rear Wheel Down 
Front Wheel Down 
Rear Wheel Up 
Front Wheel Up 
Main Relay Expectation 
Motor Relay 
Exhaust Solenoid 
FR Height Solenoid 
FL Height Solenoid 
RR Height Solenoid 
RL Height Solenoid 
Low Pressure Tank Solenoid 
Test Mode Status 
Height Control Off Switch 

BODY 
Open Door Warning 
Down The Power Window With Transmitter 
Up The Power Window With Transmitter 
Hazard Answer Back 
Wireless Door Lock Control Function 
Car Finder Function 
Panic Function 
Light Comes ON When Unlocking The Transmitter 
Unlock With 2 Time Operation By Transmitter 
Wireless Buzzer Response 
Auto Lock Time 
Lock When IG Switch Is On, Shift D 
Unlock When IG On, Shift P and Speed 0 
Driver Door Close-Open Linked, Unlock All The Door Lock 
Unlock With 2 Times Operation By Driver Door Key 
Auto Lock 
Warning By Glass Broken Sensor 
Answer Back 
Passive Mode (Security System) 
Warning By Vehicle's Horn 
Security System 
Indicator Blinking When Armed State 
Auto Lock / Shift Not P 
Automatic Door Lock Linked Shift 
Intrusion Sensor 
Warning By Self Power Siren  
Door Key Linked Power Window Up 
Door Key Linked Power Window Down 
Power Window Operation Mode When IG Switch Is Off 
Power Window Operation When IG Switch Is Off 
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Outer Mirror Auto Return 
Outer Mirror Fold Function 
Rear Door Opening Warning 
Light Reminder 
Seat Belt Warning Buzzer 
Light The I/L When ACC Off 
Battery Saver 
Lounge Illumination Control 
Lounge Illumination 
Lighting Time (2 Selection) 
Light The I/L When Unlocking With Door Key 
Light Dome Lamp When Unlocking With Door Key 
Foot Lights Set Up (All Seat)  
Response Time  
R-Linked Wiper 
Auto Wiper 
Rewipe Time 
Rewipe Function 
Speed Mode 
Angle Mode 
Auto Lock / Shift Not P 
Automatic Door Lock Linked Shift  
DRL Control Function 
Luggage Courtesy Switch 
Hood Courtesy Switch 
Luggage Door Lock / Unlock Switch 
Luggage Opener Switch 
Stop Light Switch 
Parking Brake Switch 
Key Unlock Warning Switch 
Shift P Position Switch (P1) 
Mirror Position Switch (Down) 
Mirror Position Switch (Up) 
Mirror Position Switch (Left) 
Mirror Position Switch (Right) 
Mirror Selection Switch (Left) 
Mirror Selection Switch (Right) 
P Seat Buckle Switch 
D Seat Buckle Switch 
Outer Mirror Fold Switch 
Alternator L Terminal 
Fuel Lid Opener Switch 
Sport A/T Switch 
ECT Power Mode Switch 
ECT Snow Mode Switch 
Lamp Failure Signal 
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Brake Fluid Level Warning Switch 
Driver Door Lock Position Switch 
Passenger Lock Position Switch 
Rear Lock Position Switch 
PNP Switch 
Rear Door Courtesy Switch 
P Door Courtesy Switch 
D Door Courtesy Switch 
Wiper Angle Control Motor Terminal (PA3) 
Wiper Angle Control Motor Terminal (PA2) 
Wiper Angle Control Motor Terminal (PA1) 
Washer Switch Terminal (W) 
Wiper Switch Terminal (SM) 
Wiper Switch Terminal (+1) 
Wiper Switch Terminal (C1) 
Wiper Switch Terminal (2S) 
Head Light Switch (Tail) 
Head Light Switch (Head) 
Auto Light Switch 
Front Fog Light Switch 
Rear Fog Light Switch 
Passing Light Switch 
Dimmer Light Switch 
Trunk And Back-Door Opener Switch 
IG Switch 
ACC Switch 
Trunk Opener & Metal Top Switch 
Outer Mirror Return Switch 
Outer Mirror Fold Switch 
Tail Cancel Switch 
Brake Pad Sensor Open Switch 
Auto Mirror Switch 
PSD Operation Switch (Passenger's Side) 
PSD Operation Switch (Driver's Side) 
Back Door Operation Switch 
Memory Set Switch 
Seat Memory Switch 2 
Seat Memory Switch 1  
Lock Position Switch (Except D and Back Door) 
Driver Door Key Switch-Unlock Side 
Passenger Door Key Switch-Unlock Side 
Door Key Switch-Lock Side 
Door Lock Switch-Unlock Side 
Door Lock Switch-Lock Side 
Driver Door Key Switch-Unlock Side 
Intrusion Sensor OFF Switch 
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Intrusion Sensor Detection 

Steering Pad 
Horn Switch 
Meter Multireset Switch 
Meter Multi DSP2 Switch 
Meter Multi DSP1 Switch 
Audio Mode Switch 
Audio Volume Up Switch 
Audio Volume Down Switch 
Audio Selector Up Switch 
Audio Selector Down Switch 
Audio Volume Set Switch 
Speech Recognition Hook Switch 
ACC Switch Signal 
IG Switch Signal 
Tail Lamp Signal 

BODY No3 
Rear Seat Return Switch 
High Level Warning Switch 
ECT Snow Switch 
ECT Power Switch 
PIND Switch 
WIP Switch 
MPX-IG Switch 
ACC Switch 
Wiper Switch  
Illumination System With ACC Off 
Light Control 
Illumination System  
Auto Wiper Operation Mode 
Speed Mode 

BODY No4  
Back-up Light 
High Mount Light 
License Light 
Stop Light 
Rear Fog Light 
Tail Light  
Trunk Lid Open  
Rear Defroster 
Fuel Lid Open 
Luggage Light 
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FRC (Body No 5) 
Washer Level Switch 

METER 
Tail Cancel Switch 
Trip Reset Switch 
Odo/Trip Switch  
Light Reminder 

Clearance Sonar  
Clearance Sonar Main Switch 
Keep Sense Status Buzzer 
Rear Buzzer Specified 
Front Buzzer Specified 
Rear Sensor 
Front Side Distance Sensor 
Sensor Condition N Range 
No Move Judgment Buzzer 
Approach Delay Off 

AFS 
AFS Off Switch 
Headlamp Auto Signal 
Headlamp Signal 
Generator Signal 
Transmission Position N Signal 
Transmission Position R Signal 

P-Door 
Slide Position Initial Flag 
Reclining Position Initial Flag 

P-Seat 
Memory Switch 1 
Memory Switch 2 
Seat Memory 1 
Seat Memory 2 
IG Switch 
Stop Light Switch 
Key Unlock Switch 
D-Door Warning Switch 
Shift 'P' Position Switch 
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Memory Switch No 2 
Memory Switch No 1 
SET Switch 
Reclining Rear Switch 
Reclining Front Switch 
Front Vertical Down Switch 
Front Vertical Up Switch 
Lifter Down Switch 
Lifter Up Switch 
Slide Rear Switch 
Slide Front Switch 
Headrest Switch Down 
Headrest Switch Up 
Cushion Switch Rear 
Cushion Switch Front 
Slide Switch Rear (Wireharness) 
Slide Switch Front (Wireharness)  
Shift 'N' Position Switch 
Passenger Door Courtesy 

RR-SEAT 
Refreshing ECU Stop 
Refreshing ECU Start 
Headrest Down 
Headrest Up 
Slide Rear 
Slide Front 

RL-SEAT 
Refreshing ECU Stop 
Refreshing ECU Start 
Headrest Down 
Headrest Up 
Slide Rear 
Slide Front 

R-SEAT-SW 
RR Seat Refreshing ECU Stop Switch 
RR Seat Refreshing ECU Start Switch 
RR Seat Headrest Down Switch 
RR Seat Headrest Up Switch 
RR Seat Slide Rear Switch 
RR Seat Slide Front Switch 
RL Seat Refreshing ECU Stop Switch 
RL Seat Refreshing ECU Start Switch 
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RL Seat Headrest Down Switch 
RL Seat Headrest Up Switch 
RL Seat Slide Rear Switch 
RL Seat Slide Front Switch  
IG Switch 

D-Door 
Lock Position Switch 
Jam Protection Limit Switch 
RL Door Remote Power Window Auto Switch 
RR Door Remote Power Window Auto Switch 
P Door Remote Power Window Auto Switch 
Door Power Window Auto Switch  
Glass Position (3/4 Open - Full Open) 
Glass Position (Fully Close - 3/4 Open) 
Glass Position (Fully Close - 2/4 Open) 
Glass Position (Fully Close - 1/4 Open)  
Door Key Linked Power Window Down 
Door Key Linked Power Window Up 
Full Switch 
Half Switch 
Pole Switch 
DBL Lock Position Switch 
Cam Position Switch 1 
Cam Position Switch 2 
Cam Position Switch 3 
Courtesy Switch 
Trigger Switch 
Trespass Sensor 

P-Door 
Lock Position Switch 
Jam Protection Limit Switch 
RL Door Remote Power Window Auto Switch 
RR Door Remote Power Window Auto Switch 
P Door Remote Power Window Auto Switch 
Door Power Window Auto Switch  
Glass Position (3/4 Open - Full Open) 
Glass Position (Fully Close - 3/4 Open) 
Glass Position (Fully Close - 2/4 Open) 
Glass Position (Fully Close - 1/4 Open)  
Door Key Linked Power Window Down 
Door Key Linked Power Window Up 
Full Switch 
Half Switch 
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Pole Switch 
DBL Lock Position Switch 
Cam Position Switch 1 
Cam Position Switch 2 
Cam Position Switch 3 
Courtesy Switch 
Trigger Switch 
Trespass Sensor 

RR-DOOR 
Lock Position Switch 
Jam Protection Limit Switch 
Door Power Window Auto Switch  
Glass Position (3/4 Open - Full Open) 
Glass Position (Fully Close - 3/4 Open) 
Glass Position (Fully Close - 2/4 Open) 
Glass Position (Fully Close - 1/4 Open) 
Full Switch 
Half Switch 
Pole Switch 
DBL Lock Position Switch 
Cam Position Switch 1 
Cam Position Switch 2 
Cam Position Switch 3 
Courtesy Switch 
Trigger Switch 
Rear Seat Memory Switch Memory 
Rear Seat Memory Switch Set 
Rear Seat Memory Switch Cancel 
Trespass Sensor  
PSD Switch Operation Condition 
Fuel Lid Switch 
Child Lock Switch 
B Pillar Switch 
PSD Main Switch 
Handle Switch 
Closer Position Switch 
Glass Position (3/4 Open - Full Open) 
Glass Position (Fully Close - 3/4 Open) 
Glass Position (Fully Close - 2/4 Open) 
Glass Position (Fully Close - 1/4 Open) 
RL-DOOR 
Lock Position Switch 
Jam Protection Limit Switch 
Door Power Window Auto Switch  
Glass Position (3/4 Open - Full Open) 
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Glass Position (Fully Close - 3/4 Open) 
Glass Position (Fully Close - 2/4 Open) 
Glass Position (Fully Close - 1/4 Open) 
Full Switch 
Half Switch 
Pole Switch 
DBL Lock Position Switch 
Cam Position Switch 1 
Cam Position Switch 2 
Cam Position Switch 3 
Courtesy Switch 
Trigger Switch 
Rear Seat Memory Switch Memory 
Rear Seat Memory Switch Set 
Rear Seat Memory Switch Cancel 
Trespass Sensor  
PSD Switch Operation Condition 
Fuel Lid Switch 
Child Lock Switch 
B Pillar Switch 
PSD Main Switch 
Handle Switch 
Closer Position Switch 
Glass Position (3/4 Open - Full Open) 
Glass Position (Fully Close - 3/4 Open) 
Glass Position (Fully Close - 2/4 Open) 
Glass Position (Fully Close - 1/4 Open) 

Tilt and Telescopic 
T&T Autoaway Function 
T&T Memory 3 
Tilt Up Limit Point 
Tilt Down Limit Point 
Telesco Short Limit Point 
Telesco Long Limit Point 
T&T Memory 1 
T&T Memory 2 
Belt Memory 1 
Belt Memory 2 
Tilt Up Manual Switch (MPX) 
Tilt Down Manual Switch (MPX) 
Telesco Short Manual Switch (MPX) 
Telesco Long Manual Switch (MPX) 
Key Code Confirm (MPX) 
IG Switch (MPX) 
Key Switch (MPX) 
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IG Switch 
Tilt Up Switch 
Tilt Down Switch 
Telesco Short Switch 
Telesco Long Switch 
Meter ECU Information 
Body No. 1 ECU Information 
Body No. 2 ECY Information 
Seat ECU Information 
Combi ECU Information 
Steering Lock ECU Information 
Power ECU Info 

D-Seat 
Memory Switch 1 
Memory Switch 2 
Seat Memory 1 
Seat Memory 2 
Driver Mirror Memory 1 
Driver Mirror Memory 2 
Passenger Mirror Memory 1 
Passenger Mirror Memory 2 
IG Switch 
Stop Light Switch 
Key Unlock Switch 
D-Door Warning Switch 
Shift 'P' Position Switch 
Memory Switch No 2 
Memory Siwtch No 1 
SET Switch 
Reclining Rear Switch 
Reclining Front Switch 
Front Vertical Down Switch 
Front Vertical Up Switch 
Lifter Down Switch 
Lifter Up Switch 
Slide Rear Switch 
Slide Front Switch 
Headrest Switch Down 
Headrest Switch Up 
Cushion Switch Rear 
Cushion Switch Front 
Slide Switch Rear (Wireharness) 
Slide Switch Front (Wireharness)  
Memory Switch 3 
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Seat Memory 3 
Driver Memory 3 
Passenger Mirror Memory 3  
Shift 'N' Position Switch 
IG 'Push' Position Switch  
Slide Position Initial Flag 
Headrest Position Initial Flag 
Reclining Position Initial Flag 
Temporary Stop Moving Flag  
Headrest Control 

SLIDE ROOF 
Open Switch 
Close Switch 
Tilt Up Switch 
Tilt Down Switch 
Limit Switch 1 
Limit Switch 2 
Motor Pulse 
Motor Status 
IG Switch 
IG (Bit) 
Permission Of Key Off Operating 
D-Door Warning Switch 
Door-Key Open Operation 
Door-Key Close Operation 
Wireless Open Operation 
Wireless Close Operation 
Hall IC1 Pulse 
Hall IC1 Status 
Hall IC2 Pulse 
Hall IC2 Status 
Permission Of Key Off Operating 
Slide Roof Closed Signal 
Permission Of Key Off Operating 
Open With Door-Key 
Close With Door-Key 
Open With Wireless 
Close With Wireless 
Direction Of Door-Key Operation 
Direction Of Wireless Operation 
 

MIRROR, MIRROR-R 
Mirror Position Right Switch 
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Mirror Position Left Switch 
Mirror Position Down Switch 
Mirror Position Up Switch 
Select Mirror Switch 
Reverse Position Switch 
ACC Switch 
IG Switch  
Mirror Memory 3 
Mirror Memory 2 
Mirror Memory 1 

RAIN SENSOR 
Wiper Switch Auto Signal 
Wiper Switch Hi Signal 
Wiper Switch Lo Signal 
Sensor Low Temp Condition 
Sensor High Temp Condition 
Sensor Reaction Condition 
Sensor Condition 
Key Push Switch Signal 
Key Switch Signal 
Wiper Switch Mist Signal 
Washer Switch Signal 

Combination Switch 
Light TAIL Switch 
Light HEAD Switch 
Light AUTO Switch 
Dimmer HI Switch 
Passing Light Switch 
Front Fog Light Switch 
Turn Right Switch 
Turn Left Switch 
Front Wiper INT Switch 
Front Wiper LO Switch 
Front Wiper HI Switch 
Front Wiper AUTO Switch 
Front Wiper MIST Switch 
Front Washer Switch 
Tilt UP Switch 
Tilt DOWN Switch 
Telesco LONG Switch 
Telesco SHORT Switch 
Horn Switch  
IG Switch 
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SMART KEY 
PR Door Trigger Switch 
DR Door Trigger Switch 
P Door Trigger Switch 
D Door Switch 
PR Door Touch Sensor Switch 
DR Door Touch Sensor Switch 
P Door Touch Sensor Switch 
D Door Touch Sensor Switch 
Trunk/Back Door Unlock Switch Switch 
Trunk/Back Door Lock Switch 
ACC Switch 
Ignition Switch 
Key Unlock Warning Switch 
Smart Cancel Switch  
Trunk Open Mode When The Key Is Left In A Trunk 
Trunk Open Mode When Vehicle Is Locked  
Warn A Key Is Taken Out By Fellow Passengers 
Warn A Key Is Taken From D-Door Without P Range 
Warn A Key Is Taken From D-Door With P Range 
Warn Starting E/G When The Key Is Out Of Range 
Warn When The Key Battery Becomes Weak  
C Code Difference 
ID Code Difference (Response) 
Key Low Battery 
Unmatched Response Code Or Format 
No Response 
Unmatched Vehicle ID 
Registered Condition Of Master Key ID #1 
Registered Condition Of Master Key ID #2 
Registered Condition Of Master Key ID #3 
Registered Condition Of Master Key ID #4 
Registered Condition Of Master Key ID #5 
Registered Condition Of Master Key ID #6 
Registered Condition Of Master Key ID #7 
Registered Condition Of Master Key ID #8  
ID Code Difference 
Difference Rolling Code  
Smart Cancel Switch  
Immobiliser 
Permit (Start) 
Response 
Frame Error 
Different Serial Number 
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Different Encrypt Code 
Abnormal Status 
BCC Malfunction 
Sub Key 
Master Key  
Wireless C Code 
Wireless Starter Communication ID  
Steering Lock Sleep Condition 
Steering Lock Start Condition 
Engine Start Condition 
Push Start Error 
Lock Bar Stuck Error 
Lock/Unlock Receive 
Motor Driver Open 
Motor Driver Short 
Power Supply Open 
Power Supply Short 
Sensor Value 
LG (Lin) 
IG2 Status  
IDBOX Start Condition 
IDBOX Sleep Condition 
Lock Request Receive 
Unlock Request Receive 
L Code Check 
S Code Check 
3bit Code Request 
Engine Start Request 
L Code Check (Past) 
S Code Check (Past) 
3bit Code Request (Past) 
Engine Start Request (Past) 

BACK DOOR 
Courtesy Switch 
Wiper Turn Position Switch 
Wiper Retracting Switch 
Power Window Limited Switch 
Lock Position Switch 
Unlock Switch Linked With Key 
Lock Switch Linked With Key  
Door Key Linked Power Window Down 
Door Key Linked Power Window Up  
PBD Closer Switch 
Power Window Position 
Door Lock Status 
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Back Door Handle Switch 
Full Latch Switch 
Wiper Stop Position 
Half Latch Switch 
Glass Position (Fully Close - 1/4 Open) 
Glass Position (1/4 Open - 2/4 Open) 
Glass Position (2/4 Open - 3/4 Open) 
Glass Position (3/4 Open - Fully Open) 
Door Position (Fully Close - 1/4 Open) 
Door Position (1/4 Open - 2/4 Open) 
Door Position (2/4 Open - 3/4 Open) 
Door Position (3/4 Open - Fully Open) 
PBD Assist Open Operation 
PBD Assist Close Operation 
Wireless PBD One Motion Operation 
PBD Switch Operation Condition  
PBD Main Switch 

Steering Lock 
Push Switch 
Key Switch 
IG Switch 
Lock Position Sensor 
Unlock Position Sensor 
Unlock Sensor 
P2 Switch 
+B 
Steering Lock 
Immobiliser 
Check (Security) 
Permission To Start 
G-Code Support Status 
No Response 
Frame Error 
Unrecognized Serial No 
Unrecognized Encrypted Code 
Abnormal Status 
Abnormal BCC 
Sub Key Matching 
Master Key Matching 
Registration Error 3/EFI Reg Status 
Registration Error 2/Number Error 
Registration Error 1/Password Error 
Space For Code Registration  
Security B Code Confirmation 
Communication ID Confirmation 
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FCVC Status / No Resp From FCVC For 10s While IG On 
FCVC Status / FCV Failure 
FCVC Status / Codeline Failure 
FCVC Status / Factory Code Initializing 
FCVC Status / Checksum Error 
FCVC Status / Code Incorrect Status 
FCVC Status / Unlock Status 
FCVC Status / Code Learning Status 

MIRROR-L  
Mirror Memory 3 
Mirror Memory 2 
Mirror Memory 1 

TDS  
Security Horn 2 
Security Horn 
Security Indicator  
Tail Light Relay 
Headlight Relay 
Front Fog Light Relay 
Luggage Transmitter 
In Luggage Transmitter 
RR-Sheet Transmitter 
FR-Sheet Transmitter 
PR-Sheet Transmitter 
DR-Sheet Transmitter 
P-Sheet Transmitter 
D-Sheet Transmitter  
Smart Indicator  
Buzzer Response Sound  
Buzzer 
Pager 

PWR SOURCE CONTROL 
Shift P Signal 
Steering Unlock Switch 
Card Half-Insertion Detection Switch 
Card Full-Insertion Detection Switch 
Stop Lamp Switch 2 
Stop Lamp Switch 1 
Start Switch 2 
Start Switch 1 
Neutral Switch / Clutch Switch 
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Starter Requesting Signal Monitor 
Ratch Circuit 
Ignition 1 Relay Monitor (Inside) 
Ignition 2 Relay Monitor (Inside) 
ACC Relay Monitor 
Ignition 1 Relay Monitor (Outside) 
Ignition 2 Relay Monitor (Outside) 
Starter Relay Monitor  
Driving Request Of Starter 
ACC Relay Cut Signal  
Engine Condition (Only For Non HV-Car) 
Vehicle Speed Signal 

Master Switch 
RL Door Remote Power Window Up Switch 
RR Door Remote Power Window Up Switch 
P Door Remote Power Window Up Switch 
Door Power Window Up Switch 
RL Door Remote Power Window Auto Switch 
RR Door Remote Power Window Auto Switch 
P Door Remote Power Window Auto Switch 
D Door Power Window Auto Switch  
Power Window Lock Switch 
Manual Door Unlock Switch 
Manual Door Lock Switch 
RL Door Remote Power Window Down Switch 
RR Door Remote Power Window Down Switch 
P Door Remote Power Window Down Switch 
Door Power Window Down Switch  
Seat Memory No3 
Seat Memory No2 
Seat Memory No1 
Memory Set Switch 
Door Key Linked Unlock Switch 
Door Key Linked Lock Switch 
Lock Position Sensor  
Glass Position (3/4 Open - Full Open) 
Glass Position (Fully Close - 3/4 Open) 
Glass Position (Fully Close - 2/4 Open) 
Glass Position (Fully Close - 1/4 Open)  
Wireless Power Window Down 
Wireless Power Window Up 
Door Key Linked Power Window Down 
Door Key Linked Power Window Up 
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State Encoded Values (non-CAN Bus) 

Immobiliser 
Key Discrimination 

Sequential MT 
Gear Position (Current) 
Gear Position (Target) 

ABS 
ECU IG Power Voltage 
Deceleration Switch 
Shift Position 

TPWS (Tire Pressure) 
TPWS Mode 
Main Tire 
2nd Tire 
Registered Main Tire 
Registered 2nd Tire 
Paint Color of ID1 Transmitter 
Paint Color of ID2 Transmitter 
Paint Color of ID3 Transmitter 
Paint Color of ID4 Transmitter 
Registered ID 
ID1 Battery Voltage 
ID2 Battery Voltage 
ID3 Battery Voltage 
ID4 Battery Voltage 
ID5 Battery Voltage 
 

EMPS / EHPS 
ECU Identification 
Test Mode Status 

VGRS 
Steering Sensor 1 
Steering Sensor 2 
Steering Sensor 3 
Engine Revolution (RPM) 
Motor Rev Angle Sensor U 
Motor Rev Angle Sensor V 
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Motor Rev Angle Sensor W 
Straight Angle Valid Flag 
Motor Overheat Record 
Motor Lo Power Record 
Motor Overload Record 
Record Of Wheel Speed Malfunction (Left) 
Record Of Wheel Speed Malfunction (Right) 
Test Mode Status 

BODY 
Wireless Door Lock Buzzer Volume 
Code Selection For Trunk Lid Open Function 
Back Door Power Window Open Function Code Select 
Auto Lock Specification Of Vehicle Speed 
Slight Open 
Key Reminder Buzzer Sound 
Lighting Time (3 Selection) 
Light Auto Turn Off Delay 
Control Type 
Sensitivity 
Display Extinction Release Luminous Intensity 
Entry Delay Time 
Back Door Power Window Open Function Code Select 
Rear Sunshade Delay Time 

SRS 
Driver Side Seat Position 
Passenger Classification 
Passenger Detection 
Driver (Left) Side Buckle Switch 
Driver (Right) Side Buckle Switch 
Display Type Information 

OCC (occupant detect) 
IG Switch 
Passenger Side Buckle Switch 
Passenger Classification 
Sensor Range Information 
RR Sensor Range Information 
RL Sensor Range Information 
FR Sensor Range Information 
FL Sensor Range Information 
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METER 
Key Reminder Buzzer Frequency 
Key Reminder Buzzer Volume 
Current Unit On Multi-Display 

Clearance Sonar 
Front And Rear Buzzer Volume 
Front And Rear Buzzer Frequency 
Non P/R Range Sensor 
Reverse Range Sensor 
Sonar Display Off Time 
Display Timeout Time 
Front Left Sensor 
Front Left Side Sensor 
Front Right Center Sensor 
Front Left Center Sensor 
Front Right Side Sensor 
Front Right Sensor 
Rear Left Center Sensor 
Rear Left Sensor 
Rear Right Sensor 
Rear Right Center Sensor 

P-Seat 
Status Of Motor 

AC 
Hands Free Telephone 

D-Door 
Foot Light Lighting Time 
Mirror Return Type 

P-Door 
Foot Light Lighting Time 
Mirror Return Type 

RR-DOOR 
Wireless PSD Switch Operation 
Buzzer Volume During The PSD Operation 
PSD Touch Sensor 

RL-DOOR 
Wireless PSD Switch Operation 
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Buzzer Volume During The PSD Operation 
PSD Touch Sensor 

D-Seat 
Status Of Motor 

MIRROR, MIRROR-R 
Foot Lamp Setup 

SMART KEY 
Interval To Send A Signal To Verify SMART Entry 
Wait Time To Permit Opening Door After Locking 
Smart Ignition Available Area 
Smart Door Unlock Mode 
Warn When The Key Is Left In The Vehicle 
Warn Locking Door When Engine Is Idling 
Setting Warning Buzzer Sound Number 
Smart Door Unlock Mode 

BACK DOOR 
Wireless PBD Switch Operation 
Buzzer Volume During PBD Operation 
 
PBD Touch Sensor (Left) 
PBD Touch Sensor (Right) 

Immobiliser / Steering Lock 
Registered Sub Transponder Code No 
Registered Master Transponder Code No 
Key Discrimination 

MIRROR-L 
Foot Lamp Setup 

PWR SOURCE CONTROL 
Ready Signal (Only For HV-Car) 
Power Supply Condition 
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